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Product description

Oncomine™ Comprehensive Assay v3 GX User Guide

The lon Torrent™ Oncomine™ Comprehensive Assay v3 GX (Cat. No. A46296) is a targeted, next-
generation sequencing (NGS) assay that enables the detection of single-nucleotide variants (SNVs),
insertions and deletions (INDELSs), copy number variations (CNVs), and gene fusions from 161 unique
genes. The assay is optimized for use with formalin-fixed paraffin embedded (FFPE) samples.

The assay kit provides 4 pools of multiplex PCR primers (2 pools for the DNA assay and 2 pools for the
RNA assay) and library reagents sufficient to perform up to sixteen 2-pool or eight 4-pool reactions on
the lon Torrent™ Genexus™ Integrated Sequencer System. The assay is optimized for use with the lon
Torrent™ Genexus™ GX5™ Chip. Additional Genexus™ Integrated Sequencer reagents and supplies must
be purchased separately (see “Required materials not supplied for use with the Genexus™ Integrated
Sequencer” on page 15).

This user guide provides the following instructions.

* How to use the Oncomine™ Comprehensive Assay v3 GX to perform a Sample to Result next-
generation sequencing run on the lon Torrent™ Genexus™ Purification Instrument for nucleic acid
isolation, followed by sequencing on the Genexus™ Integrated Sequencer.

* How to use the Oncomine™ Comprehensive Assay v3 GX to perform a Nucleic Acid to Result
next-generation sequencing run on the Genexus™ Integrated Sequencer.

* How to perform data analysis of the sequencing run.

The Oncomine™ Comprehensive Assay v3 GX includes the following features.
* Analysis of variants across 161 genes
¢ Automated Sample to Result workflow on the Genexus™ Integrated Sequencer in less than 1 day
* Detection of SNVs and INDELs, CNVs, and gene fusions

* Robust performance from as little as 10 ng of nucleic acid input per pool (20 ng of DNA and 20 ng
of RNA) isolated from FFPE samples, including fine needle biopsies

* Molecular standards and controls
* Content driven by the Oncomine™ Knowledgebase
* |on AmpliSeg™ chemistry
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Contents and storage

* System-installed assays preconfigured with settings that are optimized for specific application and
sample type

® Optimized Oncomine™ informatics

The Genexus™ Purification System automates the extraction and quantification of nucleic acids from
various tissue types for use on the Genexus™ Integrated Sequencer. With a single touch point and

10 minutes of hands-on time, the Genexus™ Purification System can extract both DNA and RNA
sequentially from FFPE lysates (lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit). When
connected to the Genexus™ Integrated Sequencer, the lon Torrent™ Genexus™ Software streamlines the
NGS workflow by integrating the Sample to Result workflow within a single software system.

Contents and storage

The Oncomine™ Comprehensive Assay v3 GX (Cat. No. A46296) includes the 2-pool DNA panel, the
2-pool RNA panel, Genexus™ Strip 1, and Genexus™ Strip 2-AS. The Oncomine™ Comprehensive Assay
v3 GX DNA only (Cat. No. A46294) includes the 2-pool DNA panel, Genexus™ Strip 1, and Genexus™
Strip 2-AS. The Oncomine™ Comprehensive Assay v3 GX RNA only (Cat. No. A46295) includes the
2-pool RNA panel, Genexus™ Strip 1, and Genexus™ Strip 2-AS.

Table 1 Oncomine™ Comprehensive Assay v3 GX

Contents Carrier color Number of reactions Part No. Storage

Oncomine™ Comprehensive Assay v3 GX pools!']

OCAv3 DNA Pool 1 Magenta 16 (4 reactions/tube x 4 tubes) A40281 -30°C to -10°C
(position 1, white cap)

OCAv3 DNA Pool 2 Pale green 16 (4 reactions/tube x 4 tubes)
(position 1, white cap)

OCAv3 RNA Pool 1 Pale orange 16 (4 reactions/tube x 4 tubes) A44351
(position 1, white cap)

OCAv3 RNA Pool 2 Blue 16 (4 reactions/tube x 4 tubes)
(position 1, white cap)

Genexus™ Library Strips 1 and 2-AS (Cat. No. A40252)[2:3]

Genexus™ Strip 1 Light red 2 x 32 A46812 2°Cto 8°C
(4 single-pool reactions/strip)!

Genexus™ Strip 2-AS Light blue 2 x 32 A46813 | -30°C to -10°C
(4 single-pool reactions/strip)!

' Each primer pool in the panel is provided in 4 pairs of tubes, where each tube pair contains one tube with primers in position 1 and
one empty uncapped tube in position 2.

[l Two 8-strip packs of the Genexus™ Strip 1 and Genexus™ Strip 2-AS (16 total of each strip) are provided with each kit.
Bl Can be ordered separately.
' Oncomine™ Comprehensive Assay v3 GX limits the reaction to 4 reactions per strip.

The maximum number of samples that can be analyzed per kit depends on the type of run that you
want to perform.

8 Oncomine™ Comprehensive Assay v3 GX User Guide



https://www.thermofisher.com/order/catalog/product/A46296
https://www.thermofisher.com/order/catalog/product/A46294
https://www.thermofisher.com/order/catalog/product/A46295
https://www.thermofisher.com/order/catalog/product/A40252

Chapter 1 Product information 588
Prerequisites

Workflow

# of samples

Simultaneous DNA- and RNA-based 16 FFPE tissue samples—One DNA reaction and one RNA
variant analysis

reaction for each sample.

DNA-only or RNA-only variant analysis | 32 FFPE tissue samples—16 DNA only and 16 RNA only samples

Prerequisites
Category Prerequisites
Instrument ® (Optional) Access to the Genexus™ Purification Instrument
* Access to the Genexus™ Integrated Sequencer
* Stock of reagents and supplies that are compatible with the Oncomine™
Comprehensive Assay v3 GX and the Genexus™ Integrated Sequencer
For ordering information, see “Required materials not supplied for use with the
Genexus™ Integrated Sequencer” on page 15.
Software * (Genexus™ Software 6.8.2 or later
Functional * Key steps in a next-generation sequencing (NGS) workflow
knowledge and * Main functions of the Genexus™ Integrated Sequencer
understanding * Main features of the Genexus™ Software 6.8.2 or later

Oncomine™ Comprehensive Assay v3 GX User Guide 9
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e o

Workflow overview

The following workflow outlines the key steps in performing the Oncomine™ Comprehensive Assay v3
GX run, from nucleic acid purification to sequencing and data analysis.

Plan a run in Genexus™ Software

Select an assay (page 30)

System-installed assays that are specifically configured for each sample type
are available in the Genexus™ Software. You can use the system-installed
assays in the run plan without change. To modify any assay settings, copy the
system-installed assay that best represents the experiment, then edit the assay
settings.

Enter samples (page 31)
Enter samples in the Genexus™ Software to assign sample names and provide
el

other information such as sample collection date, gender, type, and disease
category.

Plan a run (page 29)

Run plans created in the Genexus™ Software contain all of the settings that
are used in sample purification, library preparation, templating, sequencing,
and analysis, including sample information and plate location, assays, and

barcodes.

Prepare samples (page 38)

Note: If you are starting with purified nucleic acid samples, proceed to the

next step.

Dilute the samples and load the sample plate *

Quantify and dilute the nucleic acid samples, then load the sample plate.
(Optional) Add controls to the sample plate.

(page 56)
Note: This step is not required for Sample to Result runs.

10 Oncomine™ Comprehensive Assay v3 GX User Guide
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Workflow overview

Plan a run in Genexus™ Software

Load the sequencer and start a run (page 59)

Follow the step-by-step instructions on the sequencer touch screen to load the
sample plate and consumables in the Genexus™ Integrated Sequencer.

Review data and results in the Genexus™ Software
(page 67) »

View variant calls and visualize results in Genexus™ Software.

)

] &
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B Guidelines for the usage of reagents and supplies, and sample capacity .................... 13
B Reagents and supplies for use with the Genexus™ Purification Instrument ................... 14
B Required materials not supplied for use with the Genexus™ Integrated Sequencer ............ 15
® Recommended materials for use with the Oncomine™ Comprehensive Assay V3 GX .......... 20
B Recommended materials not supplied for use with the Genexus™ Purification System ........ 20
B Recommended materials for nucleic acid isolation and quantification ....................... 21

This chapter lists the reagents, supplies, and materials needed to operate the Genexus™ Purification
Instrument and Genexus™ Integrated Sequencer, and provides consumables ordering and storage
information. Reagents and supplies can be ordered as kits and starter packs, but most consumables
can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.
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Guidelines for the usage of reagents and supplies, and sample capacity

Guidelines for the usage of reagents and supplies, and
sample capacity
Table 2 provides guidelines for the usage of reagents and supplies, and sample capacity for each
sample-to-result Oncomine™ Comprehensive Assay v3 GX workflow. Table 2 provides guidelines for the

amount of each kit required based on the number of samples and the type of workflow that you are
planning to run.

Table 2 Guidelines for the amount of reagents, supplies required for each workflow type

Workflow
Assay component DNA-only RNA-only DNA + RNA
7 samples per 8 samples per | 16 samples per | 6 samples per
runl] run run run
Oncomine™ Comprehensive Y2 kit Y2 kit 1 kit ¥ kit
Assay v3 GX
(Cat. No. A46296)
OCAv3 DNA Pool 1 2 tubes - — 2 tubes
OCAv3 DNA Pool 2 2 tubes - - 2 tubes
OCAvV3 RNA Pool 1 - 2 tubes 4 tubes 2 tubes
OCAv3 RNA Pool 2 - 2 tubes 4 tubes 2 tubes
Genexus™ Library Strips 1 and Ya kit Ya kit Ya kit Y2 kit
2-AS (Cat. No. A40252)
Genexus™ Strip 1 4 strips 4 strips 4 strips 8 strips
(Part No. A46812)
Genexus™ Strip 2-AS 4 strips 4 strips 4 strips 8 strips
(Part No. A46813)
Genexus™ Templating Strips Y2 kit Vs kit Ya kit Y2 kit
3-GX5™ and 4 (Cat. No.
A40263)
Genexus™ Strip 3-GX5™ 4 strips 1 strip 2 strips 4 strips
(Part No. A46815)
Genexus™ Strip 4 4 strips 1 strip 2 strips 4 strips
(Part No. A46816)
Genexus™ Barcodes AS 14 barcodes!? 16 barcodes 32 barcodes 24 barcodes
(Cat. No. A40257, A40258,
A40259, or A40260)
GX5™ Chip and Genexus™ Y2 set Vs set Ya set Y2 set
Coupler (Cat. No. A40269)

Oncomine™ Comprehensive Assay v3 GX User Guide 13
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Reagents and supplies for use with the Genexus™ Purification Instrument

Table 2 Guidelines for the amount of reagents, supplies required for each workflow

type (continued)

Assay component

Workflow

DNA-only

RNA-only

DNA + RNA

7 samples per
runl]

8 samples per
run

16 samples per
run

6 samples per
run

GX5™ Chip
(Part No. 100081364)

1 chip (4 lanes)

Ya chip (1 lane)

Y2 chip (2 lanes)

1 chip (4 lanes)

Genexus™ Sequencing Kit

¥z kit ¥s kit Ya kit ¥z kit
(Cat. No. A40271)
Genexus™ Pipette Tips ¥s pack Ya pack Y2 pack Y2 pack
(Cat. No. A40266)
Genexus™ Pipette Tips 4 racks 3 racks 6 racks 6 racks

(Cat. No. A40266)

[ In addition to 7 samples, you can also include a NTC.
@ If you are running a NTC, the NTC uses 2 barcodes, for a total of 16 barcodes.

IMPORTANT! The information provided in Table 2 is for estimation purposes only. Only full-sized
kits are available for purchase. For ordering information, see “Contents and storage” on page 8 and
“Required materials not supplied for use with the Genexus™ Integrated Sequencer” on page 15.

Reagents and supplies for use with the Genexus™
Purification Instrument

Genexus™ Purification Instrument reagents and supplies can be ordered as kits and starter packs, but
most consumables can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.

Genexus™ Purification System

14

The Genexus™ Purification System (Cat. No. A48148) includes the following components.

Components Part. No.
Genexus™ Purification Instrument A47646
Genexus™ Purification Install Kit A48549I[1]

' Not available for separate purchase.

Oncomine™ Comprehensive Assay v3 GX User Guide
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Required materials not supplied for use with the Genexus™ Integrated Sequencer

lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit

The lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit (Cat. No. A45539) includes the
following subkits sufficient for 48 sequential DNA and RNA isolations from FFPE curls or slides.

IMPORTANT! Store all kit components in the upright orientation.

Component Part No. Storage
Genexus™ FFPE DNA and RNA Purification A45532 15°C to 30°C
Genexus™ Nucleic Acid Quantitation A45538 2°C to 8°C
Genexus™ Purification Supplies 2 A45574 15°C to 30°C

Required materials not supplied for use with the Genexus™
Integrated Sequencer

Genexus™ Integrated Sequencer reagents and supplies can be ordered as kits and starter packs. In
addition, most consumables can also be ordered individually. This section provides information about
the various ordering options.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Genexus™ Integrated Sequencer

Components Cat. No.

Genexus™ Integrated Sequencer A45727

General laboratory supplies and reagents

Item Source
MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode 4483352, 4483354
Thermo Scientific™ Adhesive PCR Plate Foils AB0626
Microcentrifugel'! MLS
2-, 20-, 200-, and 1,000-pL pipettes and appropriate filtered tips MLS
Nuclease-free microcentrifuge tubes, 1.5-mL or 1.7-mL MLS

Oncomine™ Comprehensive Assay v3 GX User Guide 15
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L!’:@!i!
Required materials not supplied for use with the Genexus™ Integrated Sequencer

(continued)
Item Source

Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice -
Nuclease-free water, molecular biology grade MLS
Isopropyl alcohol, 70% solution MLS
Wipes, disposable lint-free MLS
(Optional) Uninterruptible Power Supply (UPS)! MLS

' Must fit standard 0.2- and 1.5-mL microcentrifuge tubes and generate 15,000 x g. To convert the RPMs of your centrifuge to RCF in
units of gravity, see tools.thermofisher.com/content/sfs/brochures/TR0040-Centrifuge-speed.pdf.

2l For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptible
power supply that is compatible with 2500 W output or higher.

Genexus™ Barcodes AS

lon Torrent™ Genexus™ Barcodes AS are supplied in plates containing 32 dual barcodes per plate. The
barcodes can be ordered as a set of three plates (Cat. No. A40257), or ordered individually.

Item Label color Cat. No. Quantity Storage
Genexus™ Barcodes 1-96 AS Blue A40257 3 plates
Genexus™ Barcodes 1-32 AS Blue A40258 1 plate

Genexus ™ Barcodes 1-32AS . J*°

Qty: 32 Barcodes

2 YYYY-MM-DD A40258

[STLOTNMBR

15°C to 30°C
Genexus™ Barcodes 33-64 AS Blue A40259 1 plate
Genexus™ Barcodes 65-96 AS Blue A40260 1 plate
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Genexus™ Templating Strips 3-GX5™ and 4

o)l

Required materials not supplied for use with the Genexus™ Integrated Sequencer

lon Torrent™ Genexus™ Templating Strips 3-GX5™ and 4 (Cat. No. A40263) are ordered as kits with

8 pairs of strips per kit.

Component Carrier color | Part No. | Quantity per kit Storage
Genexus™ Strip 3-GX5™ Brown A46815 8 strips 2°C to 8°C
Yellow A46816 8 strips -30°C to -10°C

Genexus™ Sequencing Kit

The lon Torrent™ Genexus™ Sequencing Kit (Cat. No. A40271) provides reagents and solutions sufficient

to sequence up to 2 full chips.

(4 bottles total)

Component Part No. Quantity Storage
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each

Genexus™ Pipette Tips

lon Torrent™ Genexus™ Pipette Tips (Cat. No. A40266) are ordered in packs of 12 racks each. The
number of pipette tip racks that are required for your experiment depends on the number of reactions
and the sample type. For the Oncomine™ Comprehensive Assay v3 GX, see “Guidelines for the usage of
reagents and supplies, and sample capacity” on page 13 to determine the number of racks required for

your experiment.

Item

Cat. No.

Quantity

Storage

Genexus™ Pipette Tips

A40266

12 racks

15°C to 30°C

Oncomine™ Comprehensive Assay v3 GX User Guide
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Genexus™ Controls

The lon Torrent™ Genexus™ Controls kit (Cat. No. A40267) provides sufficient Genexus™ Control
Library-AS to perform four Library to Result runs. The kit also provides sufficient Genexus™ Control
Panel-AS and Genexus™ DNA Control to perform eight Nucleic Acid to Result runs.

Note: The Genexus™ Control Library-AS is barcoded with lonCode™ 0101.

Component Quantity Storage
Genexus™ Control Library-AS 1 tube
Genexus™ Control Panel-AS 8 carriers (white) -30°C to -10°C
Genexus™ DNA Control 2 tubes

GX5™ Chip and Genexus™ Coupler

18

The GX5™ Chip and Genexus™ Coupler (Cat. No. A40269) are ordered as a set that contains two chips
and two couplers. For the Oncomine™ Comprehensive Assay v3 GX, see “Guidelines for the usage of

reagents and supplies, and sample capacity” on page 13 to determine the number of chips required for
your experiment.

Each chip can accommodate up to 6 DNA and RNA samples, or 6 samples and one no-template
control.

Component Part No. | Quantity Storage

GX5™ Chip

ion torrent 6 kAOXO+%

100081364 | 2 chips |15°C to 30°C

Ol || IS

GX5 ?}%ﬁ DADGXXXXX

Genexus™ Coupler 100081252 | 2 couplers
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)l
Required materials not supplied for use with the Genexus™ Integrated Sequencer

Genexus™ Conical Bottles

Genexus™ Conical Bottles (Cat. No. A40275) are installed in the sequencing reagents bay and serve as
reservoirs for nucleotide reagent dilutions. For information on when and how to replace the bottles, see
the Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

Component Quantity Storage

Genexus™ Conical Bottles 5 bottles 15°C to 30°C
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Recommended materials for use with the Oncomine™ Comprehensive Assay v3 GX

Recommended materials for use with the Oncomine™
Comprehensive Assay v3 GX

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Recommended materials not supplied for use with the
Genexus™ Purification System

20

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item

Source

Equipment

Bench top microcentrifuge

Cole-Parmer EW-17414-06

* Eppendorf 022620304

1,000 pL Multichannel Pipette MLS
For use with Genexus™ FFPE DNA and RNA Purification Kit
Sorvall™ ST 8 Small Benchtop Centrifuge (or equivalent)], with 75007200
Thermo Scientific™ M10 Microplate Swinging Bucket Rotor (or 75005706
equivalent)?, and
Sealed Bucket; Capacity: 4 Standard or 2 Midi-Deepwell plates (Set of 2) 75005721
(or equivalent)

S50441A

Economy Lab Incubator (2, 60°C and 90°C)

fisherscientific.com

Heating block (2, 60°C and 90°C) MLS
Precision™ General Purpose Water Bath (or equivalent) MLS
Equipment and consumables for AutoLys M FFPE sample extraction[®
AutoLys M Tubes and Caps kit A38738
AutoLys M Tube Rack A37955
AutolLys M Tube Locking Lid A37954
AutoLys M TubelLifter or A37956
AutoLys M Tube Pliers A38261

Tubes, plates, and other consumables

MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with
Barcode

4483354, 4483352
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Recommended materials for nucleic acid isolation and quantification

(continued)
ltem Source
Adhesive PCR Plate Foils AB0626
RNA/ater™ Stabilization Solution AM7020
RNaseZap™ RNase Decontamination Solution AM9780
CitriSolv™ Clearing Agent 22-143-975
Xylene MLS
Ethanol, 100% MLS

1 Centrifuge must achieve an RCF of 2000 x g, have a swinging bucket rotor and accommodate deepwell plates.
[l Swinging bucket rotor must carry deepwell plates in the landscape orientation (see page 42).
Bl For use with the Genexus™ FFPE DNA and RNA Purification Kit.

Recommended sample controls

ltem Source
AcroMetrix™ Oncology Hotspot Control 969056
Seraseq™ Tri-Level Tumor Mutation DNA Mix v2 HC 0710-0097 (SeraCare)
Seraseq™ Lung & Brain CNV Mix, + 6 copies 0710-0415 (SeraCare)
Seraseq™ Breast CNV Mix, + 6 copies 0710-0412 (SeraCare)
Seraseq™ Fusion RNA Mix v3 0710-0431 (SeraCare)
Seraseq™ Fusion RNA Mix v4 0710-0497 (SeraCare)
Horizon™ ALK RET ROS RNA fusion HD784 (Horizon)

Recommended materials for nucleic acid isolation and
quantification

ltem Source

Nucleic acid isolation—One of the following kits:

MagMAX™ FFPE DNA/RNA Ultra Kit A31881

RecoverAll™ Multi-Sample RNA/DNA Workflow A26069, A26135
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Recommended materials for nucleic acid isolation and quantification

(continued)

ltem Source

Nucleic acid quantification—One of the following kits:

Qubit™ 4 Fluorometerl'l and one or more of the following kits: Q33238
* Qubit™ dsDNA HS Assay Kit (DNA samples) Q32854, Q32851
¢ Qubit™ RNA HS Assay Kit (RNA samples) Q32852, Q32855
TagMan™ RNase P Detection Reagents Kit 4316831

Nucleic acid quality control

Agilent™ Bioanalyzer™ Instrument and one or more of the following kits: G2939BA
* Agilent™ High Sensitivity DNA Kit (DNA samples) 5067-4626
* Agilent™ RNA 6000 Pico Kit (RNA samples) 50671513

(Agilent)

' Qubit™ 2.0 Fluorometer and later are supported.
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Procedural guidelines

Use only the reagents and supplies that have been verified for the Oncomine™ Comprehensive
Assay v3 GX. For a list of verified reagents and supplies, see “Required materials not supplied for
use with the Genexus™ Integrated Sequencer” on page 15 and “Recommended materials for use
with the Oncomine™ Comprehensive Assay v3 GX” on page 20.

Use good laboratory practices to minimize cross-contamination of products. Keep all tubes sealed
until immediately before loading onto the Genexus™ Integrated Sequencer.

Minimize freeze-thaw cycles of the OCAv3 DNA Pool 1, OCAv3 DNA Pool 2, OCAv3 RNA Pool 1,
and OCAv3 RNA Pool 2 tubes. Thaw only the number of panel tubes that are required for a given
experiment and keep the thawed panels at 4°C until ready to use. Store unused panels at —-30°C to
-10°C.

Note: One set of panels (OCAv3 DNA Pool 1, OCAv3 DNA Pool 2, OCAv3 RNA Pool 1, and
OCAV3 RNA Pool 2) is sufficient for preparing up to 4 libraries.

Do NOT store the OCAv3 DNA Pool 1, OCAv3 DNA Pool 2, OCAv3 RNA Pool 1, OCAv3 RNA Pool 2,
Genexus™ Strip 1, and Genexus™ Strip 2-AS on the Genexus™ Integrated Sequencer for more than
24 hours before starting an instrument run.
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Guidelines for preventing contamination

Guidelines for preventing contamination

We recommend following these guidelines to prevent cross-contamination of samples and controls
between and within sequencing runs.

Personal protective equipment

* Wear a laboratory coat that is reserved for sequencing work and is laundered frequently. If
possible, change to a fresh laboratory coat before setting up a run, or use new sleeve covers.

* Wear fresh gloves to load the instruments, including during the loading of the sequencing chip and
coupler. Do not remove gloves to install the sequencing chip.

¢ Change gloves between dispensing positive controls and no-template control (NTC) in sample plate
wells.

Equipment and instrument cleaning

* If you are preparing samples and sample plates in a hood (recommended), illuminate the hood with
UV light for 15 minutes before use.

* Before preparing for a sequencing run, decontaminate surfaces of the hood or bench where
samples or sample plates are handled, and other equipment such as vortexers, microcentrifuges,
and pipettors. Use DNAZap™ and either the RNaseZap™ RNase Decontamination Solution or the
RNase AWAY™ Surface Decontaminant reagent. Follow manufacturer instructions for the proper
storage and use of each decontamination reagent. Alternatively, a 10% solution of commercial
bleach can be used. Follow with wiping of bench and equipment surfaces with wipes moistened
with 70% isopropanol or 70% ethanol.

¢ Before and after a run, sequentially wipe instrument deck surfaces with lint-free wipes moistened
with the two DNAZap™ decontamination solutions, followed by wipes moistened with either 1) the
RNaseZap™ RNase Decontamination Solution or 2) the RNase AWAY™ Surface Decontaminant
reagent. Follow with wiping of deck surfaces with wipes moistened with 70% isopropanol or 70%
ethanol. The robotic pipettor arm can also be cleaned in this manner.

IMPORTANT! Do not spray decontamination solution or alcohol solution directly onto deck
surfaces or into deck openings. Instead, use a lint-free wipe moistened with solution to clean
surfaces. Do not use bleach to clean instrument surfaces.

* We recommend that you centrifuge the sample plate after sealing. Ensure that the centrifuge has
been wiped down and cleaned before centrifuging the plate.
Workflow tips

* After dispensing a positive control or sample (if applicable) in a sample plate well, do not pass
the end of the used tip over wells intended for other samples or NTC. This practice minimizes the
chance of depositing microdroplets in adjacent wells.

¢ If you dilute samples on the sample plate, apply the foil seal carefully between wells with an
applicator before vortexing to ensure that the seal is complete and contamination between wells
does not occur.

* |[f possible, reserve a pipettor and tips for dispensing only NTC.
* Before disposal, close or cap used sample and positive control tubes to avoid creation of aerosols.
* Avoid touching the foil seals of the reagent strips, barcode plate, and sample plate.
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Guidelines for panel and reagent use and handling

When loading the sequencer deck for a run, install the sample plate last.

After a run, seal the PCR amplification plate with a foil seal before removing the plate from the PCR
amplification station. Sealing the plate before removal helps prevent contamination of libraries if
libraries are recovered for reuse.

Guidelines for panel and reagent use and handling

Use only the reagents and supplies that have been recommended in “Recommended materials not
supplied for use with the Genexus™ Purification System” on page 20 and “Recommended materials
for nucleic acid isolation and quantification” on page 21.

Keep panel tubes capped until immediately before loading in the Genexus™ Integrated Sequencer.

If using, thaw positive controls on ice for 30 minutes. After the positive controls are completely
thawed, vortex the tubes, then centrifuge to collect tube contents. Return to ice before loading into
sample plate.

IMPORTANT! Ensure that contents of the control tubes are completely thawed before adding to
the sample plate.

Equilibrate or thaw the following reagent strips at room temperature for 30 minutes before loading
in the sequencer.

— Genexus™ Strip 1
— Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD)
— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)
Thaw Genexus™ Strip 4 on ice for 30 minutes before loading in the sequencer.

IMPORTANT! Ensure that the contents of strips that are stored frozen are completely thawed
before loading in the sequencer.

Thawed library and templating strips can be vortexed on a platform vortexer to dissolve precipitate
or dislodge air bubbles. If you vortex, you must centrifuge the strips to collect tube contents using
the Genexus™ Strip Centrifuge Adapter to hold strips during centrifugation.

For information about obtaining and using the Genexus™ Strip Centrifuge Adapter, see “Centrifuge
library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter” on page 60.

Keep the sample plate, thawed panel, Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD), and
Genexus™ Strip 4 on ice or at 4°C until ready to load in the sequencer.

Do not freeze-thaw the panel. Thaw only the number of panel tubes that are required for an
instrument run. Discard unused panel tubes after they are thawed. Store panel tubes at —-30°C to
-10°C.

If you are using an assay that uses lon AmpliSeq™ HD chemistry, do not combine the contents

of panel tubes. Forward and reverse primers must remain separate until they are combined by the
sequencer as part of the on-instrument library preparation workflow.

Do not store primer pool tubes or reagent strips on the sequencer for more than 24 hours before
starting an instrument run.
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Requirements for nucleic acid isolation, quantification,
quality control, and input amount

These are general guidelines for manual isolation and quantification of DNA and RNA for Nucleic Acid
to Result runs. If you do not dilute sample concentrations manually to the target concentration of the
assay, quantify sample nucleic acid concentrations ahead of time so concentrations are available to
enter during run planning.

For verified kits to use for isolation and quantification of nucleic acid samples, see “Recommended
materials for nucleic acid isolation and quantification” on page 21.

Quantification methods such as densitometry (for example, using a NanoDrop™ spectrophotometer)
are not recommended, because they are not specific for DNA or RNA. Use of these methods can
lead to gross overestimation of the concentration of sample nucleic acid, under-seeding of the
target ampilification reaction, and low library yields.

The recommended sample input concentration is 1.11 ng/uL for DNA samples and 0.95 ng/pL
for RNA samples. At the recommended input amount and concentrations, the instrument requires
25 L of input for DNA and RNA samples. For more information, see “Dilute the samples and load
the sample plate” on page 57.

Before each use of the kit

Thaw assay reagents as indicated:

Thaw OCAv3 DNA Pool 1, OCAv3 DNA Pool 2, OCAv3 RNA Pool 1, OCAv3 RNA Pool 2 on ice or

at 4°C for at least 30 minutes and keep on ice until immediately before loading onto the Genexus™
Integrated Sequencer.

Equilibrate Genexus™ Strip 1 and Genexus™ Strip 3-GX5™ at room temperature for at least

30 minutes before loading onto the Genexus™ Integrated Sequencer.

Thaw Genexus™ Strip 2-AS and Genexus™ Strip 4 on ice or at 4°C for at least 30 minutes and keep
on ice until immediately before loading onto the Genexus™ Integrated Sequencer.

IMPORTANT! Ensure that the strip contents are completely thawed before installing in the sequencer.

When thawed, gently tap tubes and strips on the benchtop to remove any bubbles and collect the
contents at the bottom of each tube. For information about preparing all reagents and consumables for
loading onto the instrument, see “Before you begin” on page 59.

Note: If tapping fails to dislodge a bubble, you can dislodge large bubbles using the technique that is
described in “Before you begin” on page 59.

26
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Guidelines for Genexus™ Integrated Sequencer operation

Guidelines for Genexus™ Integrated Sequencer operation

* Follow guidance that is provided by Genexus™ Software when you plan a run to determine which
consumables must be loaded and which consumables can be reused from a previous run.

¢ Follow guidance that is provided by the software when you plan a run to determine how many
samples can be run with a given assay or assays in an instrument run. The number of samples that
can be included in a sequencing run depends on multiple factors.

* One template strip pair is needed for each chip lane that is used in a run.

¢ If a chip installed in a sequencer has unused lanes, do not remove it unless you are sure that
you want to replace it with a new chip. After a partially used chip has been removed from the
sequencer, it cannot be reinserted and reused. The sequencer cannot track lane usage after chip
removal.

* You can remove a chip in one of the following situations.
— After all the lanes of a chip are used in a run, the chip shuttles to the install position and you
are asked to remove the used chip.

— When you select a run plan that requires more lanes than are available on the installed chip,
you are asked to remove the partially used chip, and the sequencer performs a post-chip
clean. In addition, you must clear consumables from the lower sequencing reagents bay, even
if only a single lane of the chip was used.

* After loading in the sequencer, reusable consumables, such as barcode plate, chips, and
sequencing reagents bay components, must be used within 14 days for optimal results.
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Precautions

Avoid nucleic acid contamination

IMPORTANT! A primary source of contamination is spurious nucleic acid fragments from previous
sample processing steps. Do not introduce amplified DNA into the work area where the instrument is
located.

Avoid chip damage

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge, ground yourself
before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the
metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

Avoid strong electromagnetic radiation

WARNING! Do not use the instrument in close proximity to sources of strong electromagnetic
radiation (for example, unshielded intentional RF sources), as these sources can interfere with proper
operation.

Protection by equipment

A WARNING! The protection that is provided by the equipment can be impaired if the instrument is
operated outside the environment and use specifications, the user provides inadequate maintenance,
or the equipment is used in a manner that is not specified by the manufacturer (Thermo Fisher
Scientific).
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Runs plans that are created in Genexus™ Software contain the settings that are used in sample
purification, library preparation, templating, sequencing, and analysis, including sample information and
plate location, assays, and barcodes. Run plans are used to track samples, consumables, and chips
throughout purification, library preparation, templating, sequencing, and data analysis.

For more information about run planning, see the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409) or the software help system.
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Types of Oncomine™ Comprehensive Assay v3 GX runs

Types of Oncomine™ Comprehensive Assay v3 GX runs

The type of run that you plan depends on your instrument configuration, assay, and sample type.

Genexus™ Software guides you step-by-step through the process to set up a run. The software prompts
you to select required information and consumables, then provides a printed run setup guide to

help you load consumables on the Genexus™ Integrated Sequencer and the Genexus™ Purification
Instrument, if applicable.

Table 3 Types of runs for use with the Oncomine™ Comprehensive Assay v3 GX

Run type Description
Sample to An integrated run for sequential and automated nucleic acid purification, quantification,
Result and sequencing. This run type requires the Genexus™ Purification Instrument to be

connected to the sequencer.

Nucleic Acid to | A sequencing run that starts with purified nucleic acid samples of known concentration
Result as input. Purified nucleic acids can be isolated and quantified using the Genexus™
Purification Instrument in stand-alone configuration. Alternatively, you can use other
manual purification and quantification kits to isolate purified nucleic acid samples. For
a list of recommended kits, see “Recommended materials for nucleic acid isolation and
quantification” on page 21.

For more information about planning other types of runs, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAND026409) or the software help system.

System-installed assays for use with the Oncomine™
Comprehensive Assay v3 GX

30

An assay is a reusable experimental design that contains the settings and parameters for sample
purification, library preparation, templating, controlling the sequencing run, analyzing, and reporting the
results. Assays also define the panels, kits, and chips that are used in a run, and specify the reference
files and threshold values for quality control and variant detection. The software files that include the
assay settings and parameters are packaged in a ZIP file called an assay definition file (ADF).

An assay can be used to plan many runs and plays an important role in enabling rapid throughput
across the purification and sequencing instruments. Assays help reduce the chance of errors, because
information is stored and then applied to runs instead of entered manually for each run.

The following system-installed assays are available in the Genexus™ Software 6.8.2 or later for use with
the Oncomine™ Comprehensive Assay v3 GX. Each system-installed assay is configured with settings
that are optimized for a specific sample type.

Note: We recommend that you update software to the latest available versions of the system-installed
assays. For more information, contact your field service representative. For information about how to
perform software and assay package updates, see “Install software and assay definition file updates”
on page 129.
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Enter samples in the Genexus™ Software

The Genexus-Oncomine-Comprehensive-GX5-w6.0.2-Combined-DNA-DNAandFusions_SW_6.8 assay
definition file (ADF) contains 3 assays: DNA, Fusions, and DNA and Fusions.

Assay name Sample type
Oncomine™ Comprehensive v3 - GX5 - DNA - w6.0.2 DNA
Oncomine™ Comprehensive v3 - GX5 - Fusions — w6.0.2 RNA
Oncomine™ Comprehensive v3 - GX5 - DNA and Fusions — w6.0.2 DNA and RNA

You can use the system-installed assays in your run plan without change. To modify any assay settings,
you can copy the system-installed assay that best represents your sequencing experiment and sample
type, then edit assay settings if needed.

¢ If you are using a system-installed assay without changes, proceed directly to “Enter samples in
the Genexus™ Software” on page 31.

¢ To modify a system-installed assay with custom settings, see the Genexus™ Software Help .

Enter samples in the Genexus™ Software

Genexus | lon Torrent Dashboard

Samples Runs Results Assays

FiterSamplesby.. = Selected Samples:0

Sampie Name T Tags T CreatedOn  + T Appt T Samgple Type T

In Genexus™ Software, the data and attributes that characterize a purified nucleic acid—or a specimen
that requires nucleic acid purification and quantitation—to be sequenced are called samples.

Before you plan a run in the Genexus™ Software, you must first enter sample information in the software
to assign sample names and provide other information.

From the Samples menu, you can add samples in multiple ways. For more information on creating and

managing samples, see the software help system, or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

Plan a Sample to Result run

This procedure applies only if a Genexus™ Purification Instrument is used with the Genexus™ Integrated
Sequencer.

Ensure that the following prerequisites are complete before you plan a Sample to Result run.
¢ Integrate a Genexus™ Purification Instrument with the system.

* Enter sample information into Genexus™ Software. For more information, see the Genexus™
Software Help.
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1.

2.

10.
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In the menu bar, click Runs » Sample to Resulit.
You can also click + Sample to Result in the Runs / Manage Runs screen.

In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, enable Generate Report to generate a variant
report that uses the default report template.

c. Click Next.

In the Assays step, select the Research Application of each assay that you want to use in the
run.
Select DNA, Fusions, or DNA and Fusions.

Use the 9P (Filter) tools in table column headings or the Filter Assays By list to find assays of
interest.

IMPORTANT! Ensure that you select the assay that corresponds with the sample type that you
use in the run. If you select the wrong assay when you plan a run, the instrument uses incorrect
settings during the run, resulting in invalid sequencing results. Available assays are listed in the
Assays / Manage Assays screen.

Only assays that are configured for Sample to Result runs are listed.
Click Next.

In the Samples step, select the checkbox next to each sample from the list that you want to run
with the assay, then in the Selected Assays pane, click Assign.

Select the Include NTC checkbox to include a no template control for the assay.

(Optional) Select the Control Sample checkbox to designate a sample as a positive control for the
assay.

If you selected more than one assay, repeat step 5 through step 7 for each assay added.
Click Next.

If needed, edit samples in one of the following ways, then click Next.

¢ Click View & Remove, make your selections, then click Update.
* (Click Remove All, make your selections, then click Assign.
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11. In the Purification step, review and edit purification selections, then click Next.

Option Description
Protocol Select a protocol from the dropdown list for each purification kit.
Selection

Elution Vol. | Modify the elution volume within the allowable range, if needed.

(uL) Quantitation requires up to 5 pL of the eluted sample. If retesting is needed, up to 10 pL
of the eluted sample is used. If the expected sample yield is limiting, manual sample
quantitation may be preferred to preserve the sample. Alternatively, you can increase
the sample elution volume in the run plan before starting the purification.

Review? ® Select the checkbox in the row of a purification kit to review the sample
concentrations after purification, before sequencing. This lets you review whether a
sample concentration is out of range for automated dilution or below the minimum
concentration needed threshold. You can then decide on a per sample-basis
whether to sequence the samples.

* Deselect the Review? checkbox in the row of a purification kit to exclude out
of range samples from sequencing. This option does not require you to review
samples during the run.

12. In the Review step, review the run plan summary.
If desired, click Save & Print to print the run setup guide. Click Save to save the run without
printing.
After saving, the run appears in the Manage Runs screen in the run list with the name you
specified.

After you select the run and load the purification instrument, the run is started on the instrument screen.

Plan a Nucleic Acid to Result run

In Genexus™ Software 6.6 and later, a run that starts with nucleic acid samples is called a Nucleic
Acid to Result run. Purified nucleic acid samples are loaded in the Genexus™ Integrated Sequencer for
library preparation, templating, and sequencing.

IMPORTANT! The Genexus™ Purification Instrument is not required for Nucleic Acid to Result
sequencing runs.

1. In the menu bar, click Runs » Nucleic Acid to Result.

Note: Alternatively, you can click 4+ Nucleic Acid to Result in the Runs / Manage Runs screen.

2. In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, ensure that Generate Report is enabled to
generate a Variant Report using the default report template.

Oncomine™ Comprehensive Assay v3 GX User Guide 33



7 Chapter 4 Plan and manage runs
Plan a Nucleic Acid to Result run

c. Click Next.

3. Inthe Assays step, select one or more assays that you want to include in the run.

a. In the Application Type column for the assay of interest, select one or more application types,
such as DNA and Fusions or DNA, to include each selected application type for the assay in
the run plan.

After selecting an assay and the research application for the assay, the list is filtered to show
compatible assays that can be selected and run at the same time.

b. If more assays are included in the run, repeat substep 3a for each extra assay.
c. Click Next.

4. Inthe Samples step, select the samples that you want to run with each application type of each
assay.

a. Select the checkbox next to each sample that you want to assign to the application type of an
assay, then in the Selected Assays pane, for the assay and application type that you want to
use for the selected samples, click Assign.

The Chip View updates to show the lanes used in the run. Lane usage is calculated based
on the number of samples (including a no template control, if selected) and the minimum read
counts per sample for the assay. For information about the GX5™ Chip lane usage for the
Oncomine™ Comprehensive Assay v3 GX, see “Chip capacity by sample type” on page 36.
Green denotes a chip lane in the run containing assigned samples within lane capacity.

If the

minimum reads per sample x number of samples

exceeds the chip or lane well capacity, a dialog box appears after you click Assign asking you
to confirm that you want to continue. After confirmation, the Chip View updates and shows
the lane color as red instead of green. The run is allowed if the lane capacity is exceeded, but
you may not achieve the required reads per sample to pass QC metrics. If needed, remove
extra samples from the run as described in substep 4c.

lon Torrent™ GX5™ Chip lon Torrent™ GX5™ Chip

oS OchDNAFus 4 OCAvSDNAFus 7

L W5.0.2 Suplas w5.0.2 Semples
Green lane color denotes lane usage and sample Red lane color denotes sample assignment that
assignment within lane capacity. exceeds lane capacity for lane 3.

b. If you selected more than one application type or assay, repeat substep 4a for each
application type for each assay in the run plan.
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c. If needed, edit samples in one of the following ways.
¢ (Click View & Remove, make the selections, then click Update.

* Click Remove All, to remove all sample assignments for all assays.

d. To include a no template control, for each application type of each assay in the run plan, in the
Selected Assays pane, select NTC.
The Chip View updates to show the lanes used in the run for the included no template
controls.

e. Click Next.

5. In the Sample Plate step, review position assignments in the sample plate. Drag-and-drop
samples and no template controls to edit the location of samples and controls, if applicable.

a. If desired, enter the extraction kit barcode for one or more samples or controls. For a single
sample, in the row of the sample of interest, in the Kit Barcodes column, enter the extraction
kit barcode or control kit barcode, if applicable. For multiple samples or controls, select the
samples and controls, then click [ Assign Kit Barcodes. In the Assign Kit Barcodes dialog
box, enter the extraction kit barcode for the samples, and if applicable, enter the barcode for
the no template control.

b. Modify the concentration of samples, if needed. For a single sample, in the row of the sample
of interest, in the Conec. (ng/pL) column, edit the concentration.

To modify the concentration of multiple samples, select the samples of interest, then click
@ Edit Concentration. In the Bulk Edit dialog box, enter the concentration for all selected
samples, then click Submit. The concentration for each selected sample is updated to the
new value.

If a sample concentration is within the designated range, the instrument does not dilute the
sample during the run. Sample concentrations must be within 0.11-1,000 ng/uL and cannot
be higher than 1,024X of the target concentration. If a sample concentration is <1,024X of
the target concentration, the sequencer dilutes the sample to the target concentration during
the run. If a sample concentration is >1,024X of the target concentration, manually dilute the
sample to the target concentration before loading on the sample plate. For more information
about sample dilution, see “Dilute the samples and load the sample plate” on page 57. If you
want to modify the sample concentration range for an assay, see “Guidelines for Oncomine™
Comprehensive Assay v3 GX settings” on page 115 and the Genexus™ Software Help.

Note: The sample volume that is required for library preparation is not adjustable. The volume
depends on the number of primer pools in the assay, sample type, and library chemistry. For
specific sample volumes to load onto the sample plate, see “Dilute the samples and load the
sample plate” on page 57.

c. Ensure that sample plate information is correct, then click Next.

6. In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.
After saving, the run appears in the Manage Runs screen in the run list with the name you
specified.

After you select the run and load the sequencer, the run is started on the sequencer screen.
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When the sequencing run is complete, you can recover the leftover volume from each library that was
prepared in the run. For more information to find, recover, and purify the leftover library preparations,
see the Genexus™ Integrated Sequencer User Guide (Pub. No. MANOO17910).

Chip capacity by sample type

Use the following guidance to determine how many samples you can load onto the GX5™ Chip. The
capacity of the GX5™ Chip varies depending on the sample type. Chip capacity information provided in
Table 4 applies to assays that use system-installed settings only.

IMPORTANT! Changes to system-installed assay settings have not been verified. We recommend
using system-installed assay settings. Consult your local Field Service Engineer before changing default
assay settings.

Table 4 GX5™ Chip lane usage by sample type (system-installed Oncomine™ Comprehensive Assay v3 GX
settings only)

Number of strips DNA RNA
Numb | Numb Number
Workflow umoero umber Strip 2 of bar | Tubes | Tubes | Tubes | Tubes
samples | of lanes Strip 1 Ag Strip 3 | Strip 4 | codes of of of of
Pool 1 | Pool 2 | Pool 1 | Pool 2
DNA only 1 1 2 2 1 1 2 1 1 — —
2 2 2 2 2 2 4 1 1 - —
3 2 2 2 2 2 6 1 1 - —
4 3 2 2 3 3 8 1 1 - —
5 3 4 4 3 3 10 2 2 - —
6 4 4 4 4 4 12 2 2 - —
7 4 4 4 4 4 14 2 2 - —
DNA and 1 1 4 4 1 1 4 1 1 1 1
RNA
2 2 4 4 2 2 8 1 1 1 1
3 2 4 4 2 2 12 1 1 1 1
4 3 4 4 3 3 16 1 1 1 1
5 4 8 8 4 4 20 2 2 2 2
6 4 8 8 4 4 24 2 2 2 2
RNA only 1 1 2 2 1 1 2 — — 1 1
2 1 2 2 1 1 4 — — 1 1
3 1 2 2 1 1 6 — — 1 1
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Table 4 GX5 Chip lane usage by sample type (system-installed Oncomine Comprehensive Assay v3 GX
settings only) (continued)

Number of strips DNA RNA
Number of | Number Number

Workflow . of bar | Tubes | Tubes | Tubes | Tubes
samples | of lanes Strip 1 Stzg 2 Strip 3 | Strip4 | codes of of of of

Pool 1 | Pool 2 | Pool 1 | Pool 2
RNA only 4 1 2 2 1 1 8 — - 1 1
5 1 4 4 1 1 10 — - 2 2
6 1 4 4 1 1 12 - - 2 2
7 1 4 4 1 1 14 — — 2 2
8 1 4 4 1 1 16 - — 2 2
9 2 6 6 1 1 18 - - 3 3
10 2 6 6 2 2 20 - - 3 3
11 2 6 6 2 2 22 — — 3 3
12 2 6 6 2 2 24 - - 3 3
13 2 8 8 2 2 26 — - 4 4
14 2 8 8 2 2 28 - - 4 4
15 2 8 8 2 2 30 — — 4 4
16 2 8 8 2 2 32 — - 4 4
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Purification protocol

Note: For safety and biohazard guidelines, see the “Safety” appendix in the following product
documentation: Genexus™ Purification System User Guide (Pub. No. MAN0018475). Read the Safety
Data Sheets (SDSs) and follow the handling instructions. Wear appropriate protective eyewear, clothing,
and gloves.

The Genexus™ Purification System, with a single touch point and 10 minutes of hands-on time,
automates the extraction and quantitation of both DNA and RNA sequentially from FFPE lysates for use
on the Genexus™ Integrated Sequencer. When connected to the Genexus™ Integrated Sequencer, the
Genexus™ Software streamlines the NGS workflow by integrating the Sample to Result workflow within
a single software ecosystem. For more information on creating assays, adding or importing samples,
and creating plans for Sample to Result runs, see the Genexus™ Purification System User Guide (Pub.
No. MANO0018475). This quick reference assumes familiarity with Genexus™ Software and the Genexus™
Purification Instrument, and is intended for more experienced users.

Plan a purification run (standalone configuration)

38

Note: If running the Genexus™ Purification System in integrated configuration, see “Plan a Sample to
Result run” on page 31 to plan a Sample to Result run in the Genexus™ Software.

In standalone configuration, plan a purification-only run through the instrument touchscreen. After
purification is complete, all purified samples are transferred to an archive plate for storage.
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Add a purification run plan (standalone configuration)

Note: We recommend that you plan the run before preparing your samples and loading into the
FFPE DNA and RNA Purification Plate 1. However, experienced users can save time by planning the
purification run during the protease digestion step of sample preparation.

1. Enter your username and password to sign in to the instrument.

2. Tap Run, then tap Add plan.

SFODEMOO1 Select Run Plan

3. Tap in the entry box, enter a unique name for the run plan, then tap Done » Next.

4. Select the lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit, then tap Next.

Select Kit
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5. Select the appropriate purification protocol, then tap Next.
* If sequentially purifying DNA and RNA, select FFPE_DNA_RNA_vX (vX is software version
dependent).
¢ If purifying DNA only, select FFPE_DNA_vX.
¢ If purifying RNA only, select FFPE_RNA_vX.

Select Protocol

6. Enable or disable Quantitation after Purification.

Note:
. The Quantitation Plate is required even if Quantitation after Purification is disabled.

. Disabling Quantitation after Purification may reduce the purification run time by up to
2.5 hours.

Run Options

Quantitat

Elution

Elution Volume RNA

7. Accept the default elution volume. If needed, select the desired elution volume from the dropdown
list, then tap Next.

8. (Optional) Change the number of samples and the sample details.

a. In the Manage Samples screen, deselect extra samples (for example, if you are only running
ten samples, deselect samples 11 and 12).

b. Tap on a sample ID to select the sample.
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c. Tap Edit, enter a new Sample ID and any Notes, then tap Save.
d. Repeat substep 8b and substep 8c for each additional sample.

e. Click Next.

Manage Samples Edit Sample De

9. Review the Purification Run Plan Details. Tap Edit to change any of your selections, otherwise
tap Next.

Purification Run Plan Details Purification Run Plan

Gancel

The new purification run plan appears in the list of available Purification Run Plans.

To delete an existing run plan, see the Genexus™ Purification System User Guide.
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Prepare samples

Procedural guidelines

IMPORTANT! Store all kit components containing liquid in the upright orientation.

* Perform all steps at room temperature (20°C-25°C) unless otherwise noted.

* Thawing or storing on ice can be substituted with thawing or storing at 4°C (2-8°C refrigerator or
prechilled benchtop cold block).

* When mixing samples by pipetting up and down, avoid creating bubbles.

* Wear clean gloves and a clean laboratory coat.

¢ Change gloves whenever you suspect that they are contaminated.

* Open and close all sample tubes carefully. Avoid splashing or generating aerosols of the samples.

* When working with RNA:
— Use a positive-displacement pipettor and RNase-free pipette tips.

— Clean laboratory benches and equipment periodically with an RNase decontamination solution,
such as RNaseZap™ RNase Decontamination Solution (Cat. No. AM9780).

— Store RNA at -90°C to -70°C.

* Volumes for reagent mixes are given per sample. We recommend that you prepare master mixes for
larger sample numbers. To calculate volumes for master mixes, see the per-well volume and add
5-10% overage.

* Incubation at 60°C can be extended 1 hour (2 hr total time) to increase DNA vyields followed by the
90°C incubation for 1 hour.

* We recommend using a plate centrifuge that holds the AutoLys M Tube Rack in "landscape"
orientation.

@ Landscape orientation—recommended @ Portrait orientation—not recommended

Note: Place AutoLys M Tube Rack in the centrifuge with
the arrow on the cover pointing outward as shown.
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* The plate chiller shuts off 60 minutes after run completion. Remove the 96-Well Nucleic Acid
Output Plate and 48-Well Nucleic Acid Archive Plate with purified nucleic acids from the instrument
within 1 hour of run completion. Proceed immediately to sequencing or properly store the nucleic
acids until use.

* The Quantitation Plate requires equilibration to room temperature for at least 30 minutes before
use.

Before each use of the kit

* We recommend the use of incubators when using AutoLys M Tubes.
* Preheat incubators to 60°C and 90°C.
* Prepare Protease Digestion and DNase Digestion solutions immediately before use.

* (Centrifuge purification plates for 30 seconds at 1,000 x g to collect the contents.

Materials required

* Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)
— FFPE DNA and RNA Purification Plate 1

— Proteinase K (red cap)
— FFPE Protease Buffer

* Genexus™ Purification Supplies 2 (Part. No. A45574)
— AutoLys M Tubes and Caps

* AutoLys M TubelLifter or Pliers

¢ AutolLys M Tube Rack

* Plate centrifuge

* Incubators (see “Recommended materials for nucleic acid isolation and quantification” on page 21
for a list of recommended incubators)

Recommended input amount

Sample type Input range Recommended input amount

FFPE tumor resections 1 x 5 pym curl/slide to 1 x 10 pm curl/slide
4 x 10 ym curls/slides

FFPE fine needle aspirate (FNA) 1 x 5 pm curl/slide to

) 4 x 10 ym curls/slides
FFPE core needle biopsy (CNB) 6 x 10 um curls/slides
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Prepare 1X Protease Digestion Master Mix

1.

2.

In a 1.5-mL low-retention microcentrifuge tube, prepare a 1X Protease Digestion Master Mix as
indicated, where n is the number of tissue samples.

Component Volume per reaction
FFPE Protease Buffer (n+ 1) x 225 pL
Proteinase K (red cap) (n+1)x10pL
Total volume (n+ 1) x 235 pL

Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

Prepare FFPE curl samples with AutoLys M Tubes

44

Alternatively, CitriSolv™ Clearing Agent, xylene, or an equivalent method for removal of paraffin from the
FFPE samples can be used to prepare samples. For more information, see appendix B in the Genexus™
Purification System User Guide (Pub. No. MAN0018475).

Digest with Protease in AutoLys M Tubes

1.

2.

Label an AutoLys M Tube for each FFPE tissue sample.

Transfer each FFPE section curl from its storage tube to a separate labeled AutoLys M Tube.

a. Invert a labeled AutoLys M Tube over an uncapped storage tube containing the curl, then
carefully invert the 2 tubes together so that the storage tube is on top.

b. Tap or flick the storage tube so that the curl falls into the AutoLys M Tube.

If the curl adheres to the storage tube, gently grasp an edge of the curl with forceps, then transfer
it to the AutoLys M Tube. Clean the forceps between samples by rinsing with nuclease-free water,
followed by ethanol or wiping with ethanol wipes. Do not reuse the forceps without cleaning.

Cap the AutoLys M Tubes tubes, place the tubes in an AutoLys M Tube Rack, then centrifuge at
2,000 x g for 1 minute to collapse the curl before the addition of buffer.

Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

Securely recap each tube to limit evaporation, then incubate the capped tubes at 60°C for
>60 minutes in an AutoLys M Tube Rack.

Incubate at 90°C for 60 minutes.
Allow samples to cool to room temperature for 5 minutes before proceeding to lift the tubes.

Lift the tubes. The following steps describe use of the AutoLys M TubelLifter to process up to
24 samples simultaneously. Alternatively, AutoLys M Tube Pliers can be used to process tubes
individually.

a. Ensure that the AutoLys M TubelLifter lever is in Position A (straight up) and the slider is in
Position 1.
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b. Slide the 24-well AutoLys M Tube Rack containing the lysed samples into the AutoLys M
TubelLifter.

c. Press the lever down from Position A to Position B, then remove the rack from the lifter.

AN

@ AutoLys M TubelLifter lever Position A @ AutoLys M TubelLifter slider positions 1 & 2
@ AutoLys M Tubelifter lever Position B
@ AutoLys M TubelLifter lever Position C

9. Slide the AutoLys M Tube Locking Lid onto the rack, then centrifuge the samples at 2,000 x g for
10 minutes.

IMPORTANT! Ensure that the embossed arrow of the AutoLys M Tube Locking Lid points away
from the center of rotation.

10. Separate the filter from the outer tube.
a. Adjust the position of the AutoLys M TubelLifter slider to Position 2.

b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubeLifter.
C. Press the lever down from Position B to Position C.
Keep the samples on ice or at 4°C.

Proceed to “Add samples to FFPE DNA and RNA Purification Plate 1” on page 49.

STOPPING POINT If needed, transfer samples to a separate labelled 1.5-mL Eppendorf™ LoBind™ tube
and store at 4°C for up to 4 days or frozen at —-30°C to —10°C for up to 7 days.
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Prepare FFPE slide samples with AutoLys M Tubes

Alternatively, CitriSolv™ Clearing Agent, xylene, or an equivalent method for removal of paraffin from the
FFPE samples can be used to prepare samples. For more information, see appendix B in the Genexus™
Purification System User Guide (Pub. No. MAN0018475).

Collect the tissue

1.

2.

7.

Label an AutoLys M Tube for each FFPE tissue sample.
Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

Use a sterile disposable scalpel with a flat blade to scrape the tissue in a single direction, then
collect the tissue into a cohesive mass on the tip of the scalpel blade.

Carefully insert the scalpel blade with the tissue mass into the 1X Protease Digestion Master Mix
in the AutoLys M Tube. Rinse the tissue from the blade into the buffer, then ensure that the entire
mass is in solution.

Remove and inspect the blade to ensure that no tissue remains on it.

Inspect the slide to ensure that all the tissue is removed (the slide should be translucent). Discard
the scalpel in a waste container for sharp objects.

Cap each tube securely, then gently flick the tube to mix and to immerse the tissue.

Digest with protease

—

46

. Incubate at 60°C for =60 minutes in an AutoLys M Tube Rack.

Incubate at 90°C for 60 minutes.
Allow samples to cool to room temperature for 5 minutes before proceeding to lift the tubes.

Lift the tubes. The following steps describe use of the AutoLys M TubelLifter to process up to
24 samples simultaneously. Alternatively, AutoLys M Tube Pliers can be used to process tubes
individually.

a. Ensure that the AutoLys M TubelLifter lever is in Position A (straight up) and the slider is in
Position 1.

b. Slide the 24-well AutoLys M Tube Rack that contains the lysed samples into the AutoLys M
TubelLifter.
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c. Press the lever down from Position A to Position B, then remove the rack from the lifter.

@ AutoLys M TubelLifter lever Position A @ AutolLys M Tubelifter slider positions 1 & 2
@ AutoLys M TubelLifter lever Position B
@ AutoLys M Tubelifter lever Position C

5. Slide the AutoLys M Tube Locking Lid onto the rack, then centrifuge the samples at 2,000 x g for
10 minutes.

IMPORTANT! Ensure that the embossed arrow of the AutoLys M Tube Locking Lid points away
from the center of rotation.

6. Separate the filter from the outer tube.
a. Adjust the position of the AutoLys M TubelLifter slider to Position 2.

b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubeLifter.
c. Press the lever down from Position B to Position C.
Keep the samples on ice or at 4°C.

Proceed to “Add samples to FFPE DNA and RNA Purification Plate 1” on page 49.

STOPPING POINT If needed, transfer samples to a separate labelled 1.5-mL Eppendorf™ LoBind™ tube
and store at 4°C for up to 4 days or frozen at -30°C to —10°C for up to 7 days.
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Load the Genexus™ Purification Instrument and start the

run

Note: Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

Materials required

Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)

— FFPE DNA and RNA Purification Plate 1
— FFPE DNA and RNA Purification Plate 2
— DNase (yellow cap)

— DNase Buffer (blue cap)

- 12-Well Tip Comb

Genexus™ Nucleic Acid Quantitation (Part. No. A45538)

— Quantitation Plate
— Quantitation Tube

Genexus™ Purification Supplies 2 (Part. No. A45574)
— 2 Purification Tip Cartridges

— 48-Well Nucleic Acid Archive Plate

— 48-Well Nucleic Acid Archive Plate Seal
96-Well Nucleic Acid Output Plate
P200 pipette and filtered tips

Prepare the consumables

48

Remove all cartridges and consumables from their packaging, then place them on the bench at room
temperature.

Equilibrate the Quantitation Plate

IMPORTANT! Allow at least 30 minutes for the Quantitation Plate to equilibrate to room temperature.

Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
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Add 1X DNase Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2

Note: Addition of DNase is not required if purifying only DNA (purification protocol FFPE DNA is
selected for the run). Proceed directly to “Add samples to FFPE DNA and RNA Purification Plate 1” on
page 49.

The FFPE DNA and RNA Purification Plate 2 contains magnetic beads in row H.

1. Vortex the DNase Buffer and DNase supplied in the kit for ~5 seconds each, then briefly centrifuge
to collect the contents.

2. In a 1.5-mL low-retention microcentrifuge tube, prepare a 1X DNase Digestion Master Mix as
indicated, where n is the number of tissue samples.

Component Volume per reaction
DNase Buffer (n+1) x99 pL
DNase (n+1)x1.0pL
Total volume (n+1)x100 pL

3. Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

4. Centrifuge the FFPE DNA and RNA Purification Plate 2 at 1,000 x g for 30 seconds to collect the
contents.

5. Carefully remove the plate seal without disturbing the contents.

6. Pipet 100 uL 1X DNase Digestion Master Mix into each well that is used in Row A of the FFPE DNA
and RNA Purification Plate 2.

Add samples to FFPE DNA and RNA Purification Plate 1
The FFPE DNA and RNA Purification Plate 1 contains magnetic beads in row B.

1. Centrifuge the plate at 1,000 x g for 30 seconds to collect the contents.

IMPORTANT! Do not create bubbles when preparing the plate.

2. Inspect the plate to ensure that the contents of all rows are at the bottom of the wells.
3. Carefully remove the plate seal without disturbing the contents.

4. Transfer 200 pL of each sample to an individual well in row A of the prefilled FFPE DNA and RNA
Purification Plate 1.

Start the purification run

1. In the instrument touchscreen, tap Run, then tap to select the run plan that you created for this
run.

2. Ensure that the run plan selected is correct, then tap Next.
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3. (Optional) Import sample information.

The import overwrites the existing Sample ID and Notes information for each sample. That is, if
the run plan has 6 samples, the sample import file must include information for at least 6 samples.

To import sample information, prepare a CSV sample import file and save it to a USB drive. See
the Genexus™ Purification System User Guide (Pub. No. MAN0018475).

a. In the Sample Assignment screen, tap Manage Samples.
b. In the Manage Samples screen, tap Import.
c. In the Sample Import screen, tap Import to proceed.

d. Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

e. (Optional) Tap Details to view the CSV file that lists the sample names to be imported.

f. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, select
a sample, then tap Edit to modify the Sample ID or Notes.

4. Tap Next.
The instrument performs a 2-minute UV cleaning, then unlocks the door.

5. Open the instrument door.

Load the Genexus™ Purification Instrument

Follow the on-screen prompts to load the Genexus™ Purification Instrument.

Load Deck

Screen display for an instrument fully loaded for an FFPE sample purification run.
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Load FFPE DNA and RNA Purification Plate 1 & 2

1. Load the FFPE DNA and RNA Purification Plate 1 (DNA plate) prepared in step 4 of “Add samples
to FFPE DNA and RNA Purification Plate 1” on page 49.

2. Load the FFPE DNA and RNA Purification Plate 2 (RNA plate) prepared in step 6 of “Add 1X DNase
Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2” on page 49.

Load the 12-Well Tip Comb, Purification Tip Cartridges, 96-Well Nucleic Acid Output
Plate, and 48-Well Nucleic Acid Archive Plate

1. Unwrap, then load a new 12-Well Tip Comb.
Ensure that the 12-Well Tip Comb is straight and that the tabs are not bent or broken. If needed,
gently bend the tip comb in the opposite direction to the curvature to straighten the tip comb
before installing it.

2. Unwrap, then load a new 48-Well Nucleic Acid Archive Plate.

3. (Integrated configuration) Load a new 96-Well Nucleic Acid Output Plate into the output plate
position.
The 96-Well Nucleic Acid Output Plate is not required when performing the purification in
standalone configuration.
After a Sample to Result purification run, the 96-Well Nucleic Acid Output Plate becomes the
sample plate to be loaded in the Genexus™ Integrated Sequencer.

4. Unwrap two new Purification Tip Cartridges, remove the cover to expose the pipette tips, then load
the cartridges in both tip box positions.

Load the quantitation reagents and consumables

IMPORTANT!
. The Quantitation Plate is required even if your run plan does not include sample quantitation.

. The Quantitation Tube is not required if your run plan does not include sample quantitation.

1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
2. Load the Quantitation Plate.

3. (If needed) Slide and hold the quantitation module cover to the left, then insert the Quantitation
Tube. Press down firmly to properly seat the tube, then allow the module cover to close.

WARNING! Do not force the module cover closed. Forcing the module cover closed can
damage the instrument.
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Confirm that consumables are installed correctly
1. Confirm the following.

¢ Foil seals are removed from the purification plates. Do not remove foil seal from the
Quantitation Plate.

e Each component is at the correct location and in the correct orientation. Press down on all
plates and cartridges to ensure that they are firmly seated in place.

e The Tip Combs are in place.

¢ The Quantitation Plate is in the correct location, is in the correct orientation, and is locked in
place.

¢ (If needed) The Quantitation Tube is firmly seated in the quantitation module.

e Each Purification Tip Cartridge is in the correct location, in the correct orientation, and locked
in place.

If the vision system detects an error, the location indicator does not turn gray in the touchscreen.
2. If needed, tap Help, then accept each warning message appropriately to proceed.
Start the run
1. When all reagents and consumables are loaded in the Genexus™ Purification Instrument, tap Next.
2. Close the instrument door.

3. Tap Start.

The time remaining until the purification is complete is displayed and the interior lighting turns
green.

When the run is complete, the interior light turns blue, and the touchscreen displays Run Complete.
Quantitation results are available immediately. See “View and export quantitation results” on page 54.

Unload purified DNA and RNA

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. In the touchscreen, tap Unload.
The door unlocks.

2. Lift the instrument door to access the instrument deck.
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3. (Sample to Result run) Remove the 96-Well Nucleic Acid Output Plate that contains the purified
sample DNA and RNA that is ready for the addition of positive or nontemplate sample sequencing
controls. Store on ice or at 4°C. If quantitation was performed, the sample concentration
information is visible in the Genexus™ Software. Alternatively, determine sample concentrations
manually, if needed.
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@ Paired purified DNA-A1 and RNA-B1 from sample 1. C1 + D1 = sample 2, E1 + F1 = sample 3, etc. For a given
purification run, reference the plate map in the run setup guide for the well location of each purified nucleic
acid.

® DNA
® RNA

STOPPING POINT If not sequencing immediately, seal the plate with an Adhesive PCR Plate Foll
(Cat. No. AB0626), then store the plate at —20°C for up to 1 week. For long term storage (>1 week),
transfer the samples to labeled low-retention tubes, then store the DNA samples at —-30°C to -10°C
and the RNA samples at —90°C to —70°C for up to 36 months.

4. Remove the 48-Well Nucleic Acid Archive Plate that contains the purified sample DNA and RNA.
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@ DNAisin wells A1-B4. DNA samples always start @ RNA is in wells B5-C8. RNA samples always start
in well A1. in well B5 regardless of how many samples are
purified.
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Note: (Purification configuration only) If using the purified DNA or RNA immediately, transfer the
sample to a sample input plate for sequencing. To determine the sample concentrations, see “View
and export quantitation results” on page 54.

For short-term storage, seal the plate with a 48-Well Nucleic Acid Archive Plate Seal. Store the
plate at —20°C for up to 3 months. For long-term storage (>3 months), transfer samples to labeled
low-retention tubes, then store the DNA samples at —-30°C to —10°C and the RNA samples at -90°C
to —70°C for up to 36 months.

View and export quantitation results

Purification runs that include sample quantitation produce sample concentration results that can be
accessed after the run is complete. In integrated configuration, view the Run Report that is available
in the Genexus™ Software to see the sample concentrations. In standalone configuration, sample
concentration results can be accessed from the Run Complete screen or the Home screen as
described here.

1.

6.

54

In the Run Complete screen, tap View report.
The Saved Experiment Reports screen opens.

At any time after unloading and UV cleaning the instrument, sample concentration results can be
accessed through the Home screen. Tap @ (Settings).

In the Settings screen, tap Data Management.

In the Saved Experiment Reports screen, tap v or A to page through the list. Locate the
Experiment Name of interest, tap in the row to select the experiment, then tap View Report.

In the Run Report screen, tap Quant Results to view the sample concentration results.

Run Report

Standalone

Quant Results

Insert a USB drive into the USB port on the front of the instrument, then tap Export CSV. Navigate
to the file destination, then tap Save.
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Dispose of used consumables and UV clean the instrument

Unload purified nucleic acid samples before disposal of used consumables.

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. Remove and discard the deep-well sample input plates.
a. Remove the FFPE DNA and RNA Purification Plate 1 from the instrument.

b. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

A WARNING! Liquid waste contains guanidine thiocyanate, dispose of properly.

c. Dispose of the deep-well plate in an appropriate waste container.
d. Repeat substep 1a through substep 1c to discard the FFPE DNA and RNA Purification Plate 2.

2. Unlock, then remove and dispose of the Purification Tip Cartridges in an appropriate waste
container.

3. Unlock, then remove and dispose of the Quantitation Plate.

a. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

WARNING! No data are currently available that address the mutagenicity or toxicity of the
Qubit™ RNA BR Reagent (Component A). This reagent is known to bind nucleic acid and is
provided as a solution in DMSO. Treat the Qubit™ RNA BR Reagent with the same safety
precautions as all other potential mutagens and dispose of the dye in accordance with local
regulations.

b. Dispose of the deep-well plate in an appropriate waste container.

4. Open the quantitation module cover, remove and discard the Quantitation Tube, then allow the
module cover to close.

5. Close and lock the instrument door by pressing down on both top corners, then tap Start UV
Clean.

The time remaining in the UV cleaning is displayed. When complete, the instrument is ready to
start a new purification run.
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Nucleic Acid to Result runs

When performing a Nucleic Acid to Result run on the sequencer, you must quantify and dilute the
samples, then load the sample input plate. If sample purification and quantitation was performed
using the Genexus™ Purification Instrument in stand-alone configuration further sample quantitation is
not needed and sample concentrations are available in the instrument software. Alternatively, nucleic
acid samples can be manually purified and quantified using a recommended kit, see “Recommended
materials for nucleic acid isolation and quantification” on page 21.

For information about chip capacity, see “Chip capacity by sample type” on page 36.

Nucleic acid samples with concentrations up to 1,024X of the target concentration for an assay
(displayed as default values in the Sample Plate step screen in run planning) are in range for automated
dilution and require no manual dilution. Enter the concentrations during run planning at the Sample
Plate step (see “Plan a Nucleic Acid to Result run” on page 33).

Quantify nucleic acid samples

Isolate nucleic acid samples using one of the verified procedures and kits listed in “Recommended
materials for nucleic acid isolation and quantification” on page 21.

IMPORTANT! The correct input amount of nucleic acid is critical for assay success. Use a Qubit™
Fluorometer to accurately measure sample concentration before you proceed to “Dilute the samples
and load the sample plate” on page 57.

Analyze 1 pL of nucleic acid sample using a Qubit™ Fluorometer with one of the following assay kits.
Follow the procedure in the corresponding user guide to prepare samples and standards, then calculate
sample concentration.

Sample type Kit User Guide

DNA Qubit™ dsDNA HS Assay Kit | Qubit™ dsDNA HS Assay Kits User Guide
(Pub. No. MAND002326)

RNA Qubit™ RNA BR Assay Kit | Qubit™ RNA BR Assay Kits User Guide
(Pub. No. MAN0001987)
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Dilute the samples and load the sample plate

Before you proceed, use a Qubit™ Fluorometer to accurately measure sample concentration. For more
information, see “Quantify nucleic acid samples” on page 56. If you want to run sample controls, select
an appropriate control for your sample type as recommended in “Recommended sample controls” on
page 21.

1. Use the run setup guide to dilute samples and sample controls, if used, to the required
concentration using nuclease-free water (see “Plan a Nucleic Acid to Result run” on page 33).

IMPORTANT! Make sure to dilute samples to the concentration that was specified in step 5 in
“Plan a Nucleic Acid to Result run” on page 33.

Table 5 Sample concentration for Oncomine™ Comprehensive Assay v3 GX

Sample type Recommended nucleic acid concentration
FFPE DNA 1.1 ng/pL
FFPE RNA 0.95 ng/uL

2. Add 25 pL of diluted samples to the sample plate, to the wells that are specified in the run setup
guide.

Note: The Oncomine™ Comprehensive Assay v3 GX requires 20 pL of sample with 5-pL overage.

3. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil.

IMPORTANT! Do NOT use other brands of aluminum sealing tape.

4. Place the plate on ice until ready to load in the sequencer.

Sample to Result runs

If the DNA and RNA samples were not quantified on the Genexus™ Purification Instrument, you must
quantify the samples. See “Quantify nucleic acid samples” on page 56.

When performing a Sample to Result sequencing run, the 96-Well Nucleic Acid Output Plate from

the purification instrument can be loaded directly on to the sequencer as the sample input plate for
DNA-only or Fusions (RNA-only) workflows. For the DNA and Fusions sequencing run workflow, purified
and quantified DNA and RNA samples, and no template controls must be transferred to a new 96-well
input plate as specified in the run setup guide.

For information about chip capacity, see “Chip capacity by sample type” on page 36.

Note: No template controls included in the run plan are added to the 96-well output plate by the
Genexus™ Purification Instrument.

If positive controls were included in the DNA-only, Fusions (RNA-only), or DNA and Fusions run plan,
you must manually add positive controls to the sample input plate, before loading the plate in the
sequencer. For more information, see “Nucleic Acid to Result runs” on page 56.
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Transfer DNA and RNA samples to the sample input plate

To perform DNA and Fusions sequencing runs the DNA and RNA samples must be transferred from
their respective purification output plates to a new 96-well sample plate for loading onto the sequencer.
If any controls were included in the run plan, you must manually add positive controls and no template
controls to the sample input plate, before loading the plate in the sequencer. For more information on
the appropriate controls see “Recommended sample controls” on page 21.

For Sample to Result runs nucleic acid sample concentrations are transferred automatically from the
integrated Genexus™ Purification Instrument to the Genexus™ Software. Samples up to 1,024X of the
recommended target concentration for the assay (displayed as default values in the Sample Plate step
screen in run planning) are diluted to the target concentration on the Genexus™ Integrated Sequencer
during the run.
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After you have planned a run in Genexus™ Software (see Chapter 4, “Plan and manage runs”), use
the run setup guide provided by the software to load samples in the sample plate, and to determine
which consumables to load in the sequencer. Follow the step-by-step instructions in the sequencer
touchscreen during run setup. The vision system of the sequencer tracks the addition of consumables
in real-time and alerts you if a component is loaded in an incorrect position, an incorrect quantity is
loaded, an incorrect consumable is loaded, or if an expired reagent is loaded.

Instrument run times

Table 6 Total instrument run time required for each workflow type

DNA-only RNA-only DNA + RNA
7 samples per run 8 samples per run 16 samples per run 6 samples per run
~22.5 hrs ~18 hrs ~22.5 hrs ~30 hrs

Before you begin

Before setting up a sequencing run, review general procedural guidelines for handling panels, reagents,
and samples to minimize the chance of contamination. For more information, see “Guidelines for panel
and reagent use and handling” on page 25 and “Guidelines for preventing contamination” on page 24.

1. Remove primer pool tubes in tube carriers that are needed for the run from the freezer, then thaw
at room temperature for 30 minutes. After thawing, gently tap the primer pool tube or tubes on a
bench surface to ensure that contents are collected at the bottom of the tubes. Keep the tubes and
carriers on ice or at 4°C until you load them in the sequencer.

2. If you are installing a new Genexus™ Cartridge, thaw the cartridge at room temperature for
30 minutes before installing in the sequencer.
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3. Remove the library and templating strips from their packaging in the refrigerator or freezer, and
prepare them for loading in the sequencer.
¢ Equilibrate or thaw the following reagent strips at room temperature for 30 minutes.
— Genexus™ Strip 1
— Genexus™ Strip 2-AS. If you are delayed in loading, keep the thawed strips on ice or at
4°C until you load them in the sequencer.
— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)

¢ Thaw Genexus™ Strip 4 by laying the strips on ice for 30 minutes, or incubating at 4°C for
30 minutes. If you are delayed in loading, keep the thawed strips on ice or at 4°C until you
load them in the sequencer.

IMPORTANT! Ensure that contents of strips that are stored frozen are completely thawed before
installing in the sequencer.

4. Vortex each strip at maximum speed for 5-10 seconds while rocking the strips from side to side.

Note: Vortexing helps dislodge magnetic beads that can be trapped in keyholes of Genexus™
Strip 1 and Genexus™ Strip 3-GX5™, and to dissolve precipitate in Genexus™ Strip 2-HD, if present.

Note: Load the Genexus™ Integrated Sequencer within 2 hours of thawing reagents.

Proceed to “Centrifuge library and templating reagent strips using the Genexus™ Strip Centrifuge
Adapter”.

Centrifuge library and templating reagent strips using the
Genexus™ Strip Centrifuge Adapter

Note: The Genexus™ Strip Centrifuge Adapter can also be used to centrifuge Genexus™ Primer Pool
Tubes.

You can use the Genexus™ Strip Centrifuge Adapter as a holder for centrifuging library and templating
strips to collect contents in the bottom of strip wells after vortexing the strips. Users can contact
Technical Support or a Thermo Fisher Scientific Field Service Engineer to request the adapter (Part No.
A53852). Use of the adapter requires a centrifuge with buckets that support the height of the adapter
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at 44 mm so that buckets swing freely in the centrifuge rotor when loaded with strips. To use the
Genexus™ Strip Centrifuge Adapter, follow these steps.

1.

After thawing, vortex each strip at maximum speed for 5-10 seconds while rocking the strip from
side to side.

Load the strips in the adapters in a balanced orientation, then place each adapter loaded with
strips in the centrifuge. The centrifuge buckets must support the height of the adapters loaded
with strips.

Centrifuge the strips at 300 x g for 15 seconds.

Remove strips from the adapters, then inspect the strips to ensure that contents have been
collected and air bubbles are not present.

If brown magnetic beads are still visible in the tube keyhole near the foil seal, invert the strip to
resuspend the contents, then repeat step 3.

Note: It is not necessary to dislodge all the beads trapped in a keyhole—dislodging most beads is
sufficient.

Repeat step 1 through step 4, if needed, for the remaining library and templating strips to be
loaded in the sequencer.

After centrifugation, keep each strip on ice or 4°C until you are ready to load the strips in the
sequencer.

Load the sequencer and start a run

IMPORTANT! The GX5™ Chip is needed for the Oncomine™ Comprehensive Assay v3 GX. Ensure that
the correct chip is loaded in step 5.

1.

Tap Run on the sequencer home screen to start the loading procedure.

Genexus Integrated Sequencer

Oncomine™ Comprehensive Assay v3 GX User Guide 61



[~ |

S

62

Chapter 7 Load the sequencer and start a run
Load the sequencer and start a run

2.

In the Run Selection screen, select the run that you want to use from the list.

If you select a run that requires more lanes than are available on a currently installed chip, a dialog
box appears giving you the option to install a new chip, or cancel. If you proceed with a new chip,
a post-chip clean is performed, then the sequencer prompts you to perform the following steps.

* Clear Deck * Clear Sequencing Reagents
e UV Clean * Load Sequencing Reagents
* Load Deck

Note: A post-chip clean takes about 90 minutes to complete.

In the Review Run screen, confirm the run selections, then tap Next.
The deck door opens automatically.

In the Load Deck screen, the sequencer instructs you step by step to load each required
consumable in a highlighted position on the deck. The sequencer detects the loading of each
consumable in real time and advances to the next component automatically.

IMPORTANT!

. Ensure that you remove the primer pool tube cap or caps before installing the tube carrier on the
deck.

. Ensure that you load the correct type of barcode plate, library Strip 2, and templating Strip 3B
for the type of run you are setting up. The sequencer displays a warning if you have installed
consumables that are incompatible with the run you have selected, for example, a Genexus™
Barcodes AS plate or Genexus™ Strip 2-AS in an HD run.

. Ensure that you remove the lids from all the boxes of Genexus™ Pipette Tips before you load the
boxes in the sequencer.

. After removing the tip box lid, visually inspect tip boxes to ensure that all tips are seated level
in the tip rack before and after placing on the instrument deck. If a bent or damaged tip is
suspected, replace the tip box with a new tip box. Reracking of tips from partially used boxes is
not supported and can cause some tips to seat at an angle, which can affect run performance.

. Ensure that all tip boxes sit level on the deck by visually inspecting all boxes across the tip
station. Reseat the boxes before starting the run, if needed.

. Do not use third-party pipette tips or rerack third-party tips into used Genexus™ Pipette Tips
boxes. Use of third-party tips can result in sequencing run failure.

. Load instrument plates, including the PCR plate, barcode plate, enrichment plate, and sample
plate, into position by pressing down firmly and evenly on all sides and corners of each plate.

. Check any errors carefully before proceeding. Tap Help to view the errors.
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5. If prompted, insert a new chip and Genexus™ Coupler. Insert the chip into the chip install slot with
the chip notch oriented down and toward the front of the instrument.

@ Notched corner of chip

IMPORTANT! Insert the Genexus™ Coupler so that it is level to properly align with the chip. A
coupler that is installed at an angle or is not level will not align properly to the chip and can result in
a failed run.

6. When the deck consumables have been loaded, lock the library and templating strips in place by
sliding the latches toward the rear of the deck.
If a chip is detected and the strip latches are closed, the Close Deck Door screen appears.

7. Close the deck door, then tap Next.

* |f you installed a new chip in the sequencer, the sequencer prompts you to open the
sequencing reagents bay doors to empty the waste and remove used sequencing reagents
bay consumables. Proceed to step 8.

* If you are using a chip that was previously installed and has sufficient lane capacity for the run,
the sequencer starts the run.

IMPORTANT! The cartridge and bottles in the sequencing reagents bay must be replaced every
time that a new chip is installed, regardless of how many lanes were used in the previous chip.

8. Follow on-screen instructions to empty the waste in the Waste carboy, remove waste pipette
tips, remove the used Genexus™ Bottle 1, Genexus™ Bottle 2, Genexus™ Bottle 3, and Genexus™
Cartridge, then tap Next.

IMPORTANT!

. Ensure that you empty and replace the Waste carboy and the waste pipette tip bin.

. After replacing the emptied Waste carboy, ensure that you reinsert the waste tube into the
carboy.

. Follow all applicable local, state/provincial, and/or national regulations when recycling or
disposing of consumables and liquid waste.
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9. Install a new Genexus™ Bottle 1, Genexus™ Bottle 2 (two required), Genexus™ Bottle 3, and
Genexus™ Cartridge.

IMPORTANT!

. Before installing, gently invert each Genexus™ Bottle 2 five times to mix—avoid vigorous mixing.
Inspect the plastic nozzles for any pinches or deformations. To avoid pinching or folding of the
plastic nozzle, install the bottles straight-on, not at an angle.

. The installed reagents can be used for up to 14 days on the sequencer with full performance.
After 14 days, you may observe reduced performance.

After reagents are installed, the Close Sequencing Reagent Bay Door screen appears.

10. Close the sequencing reagents bay doors.
After the doors are closed, the sequencer starts the run.

At the beginning of the run, the instrument chip coupler check verifies the chip, checks for leaks,
then calculates run time.

A sequencing run encompasses the following stages.

1. Starting 5. Pre-sequencing
2. Initializing 6. Sequencing

3. Library Prep 7. Cleaning

4. Templating

At each stage, the instrument shows the time remaining on the touchscreen.

Sequencing

‘ Qﬂ“ ..ﬁg
& %.

00:31:24
Library Prep

%*n ll“rf&e

When the run finishes, the sequencer displays the Run Complete screen.
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Clear the instrument deck and perform a UV Clean

After a run completes, remove used consumables from the deck and perform a UV Clean to ready the
instrument for the next run.

1. In the Run Complete screen, tap Next to start removal of used consumabiles.

Sequencing

Run
Complete

The deck door opens.

2. In the Clear Deck screen, the sequencer provides step-by-step instructions by highlighting the
components to be removed. Unlock the library and templating strips by sliding the latches toward
the front of the deck, then remove the used strips. Remove the remaining deck components
specified by the sequencer.

3. Inspect the Genexus™ Filter in the liquid waste disposal port and verify that no standing liquid is
present. If standing liquid is present, manually remove the liquid with a pipette, then pull out the
filter. Test the filter with water to determine if a clog is present.

¢ [f the Genexus™ Filter is clogged, replace it with a new filter. For more information, see
"Replace the Genexus™ Filter" in the Genexus™ Integrated Sequencer User Guide (Pub. No.
MANO0017910).

* |f the Genexus™ Filter does not appear to be clogged, a line clog downstream of the filter is
implicated. Contact Technical Support and report a possible deck liquid waste line clog.

4. When finished, close the deck door, then tap Next.
A two-minute UV Clean starts.
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5.

A

6.

After UV cleaning, if all the chip lanes were used, the sequencing reagents bay doors unlock. Open
the doors, remove used components from the bay and empty the Waste carboy, then tap Next.

IMPORTANT! Do not discard or remove the conical bottles, unless alerted by the sequencer to
replace the bottles after a conical bottle flow rate test. For more information, see the Genexus™
Integrated Sequencer User Guide.

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when
recycling or disposing of Genexus™ Integrated Sequencer consumables and liquid waste.

CAUTION! The Genexus™ Bottle 1 (small waste bottle) contains small amounts of formamide.
Dispose of this waste appropriately.

After removal of used components, close the sequencing reagents bay doors, then tap Next.
The sequencer returns to the home screen.
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Use the Results menu to review run results and data analysis and perform data management tasks.
You can view results sorted by sample or by run.

View data and results

Use the Results menu to review run results and data analysis and perform data management tasks.
You can view results sorted by sample or by run.

The run report provides detailed information about a run, such as the Total Bases and Final Reads.
The run report contains the assay metrics for all assays in the run.

Assay-level results include assay metrics, such as final read data. Assay metrics are also shown in the
Run Report tab. For more information, see “View assay metrics and the run report” on page 116.

Samples that are run with the same assay in the same run share the same Run Report. All other results
are specific to the sample and are shown in the sample results.

In the menu bar, select one of the following options.

Selection Description

Click Results » Run Results Select this option to review completed run results and reports by assay.
Proceed to “Review run results” on page 70.

Click Results » Sample Select this option to review completed sample results and reports.

Results Proceed to “View sample results” on page 73.

Click Results » Verification Select this option to review data from completed verification runs that were
Results performed during sequencer installation or performance qualification.

We recommend selecting this option only when recommended by support.
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After you select a run result or a sample result, a results navigation bar appears and allows you to

easily toggle between different results screens for each run. You can switch between run-level results,
assay-level results, and sample-level results for the run.
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Results navigation bar overview

After you select a run result or a sample result, a results navigation bar appears and allows you to easily
toggle between different results screens for each run. You can quickly switch between run-level results,
assay-level results, and sample-level results for the run.

Assay-level results include assay metrics, such as final read data. Assay metrics are also shown in the
Run Report tab. For more information, see “View assay metrics and the run report” on page 116.

Samples that are run with the same assay in the same run share the same Run Report. All other results
are specific to the sample and are shown in the sample results.

Results / JJ

v OCAv3 DN 2% (S1V¥

A FUS Wo.U.
S1 QC Key Findings  Variants Plugins Reports

Sample Details
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Callout Dropdown Description
menu
1 Run Name The run name is listed. Multiple runs are listed only if the run has been reanalyzed. For

more information, see “Reanalysis” on page 129.

2 Select Assay

You can click the assay name of interest to view assay metrics for the run.

You can toggle between different assays used in the run. If only one assay is associated
with the run, only one assay name is listed.

Some results from a plugin that is included in the run, such as the customer support
archive (CSA) plugin, apply to all of the samples for an assay in a run. In this case, the
results from assay-level plugin are shown in the Plugins tab when you select an assay but
do not select any samples for the run. For more information about plugins, see “Review
plugin results in Genexus™ Software” on page 92.

You can choose Select Assay from the dropdown list to remove the assay selection.
Removing the assay selection opens the Run Summary tab for the run selected in the Run
Results dropdown list.

3 Select
Sample

You can click a sample name to view the sequencing results for the sample. You can click
a different sample name to view other sample results for other samples in the run for the
assay that is selected in Select Assay.

You can choose Select Sample from the dropdown list to remove the sample selection.
Removing the sample selection opens the Run Report tab for the assay selected in the
Select Assay dropdown list.

For Sample to Result runs that include a positive control, results for the positive control
are shown when you select Control Sample.

For Sample to Result runs that include a non-template control (NTC), results for the NTC
are shown only in the QC tab under Sample QC. The NTC sample is not listed in the Select
Sample dropdown list.

Review run results

Use the Results / Run Results screen, runs that are pending, in progress, or completed are listed.
Runs with a status of failed, aborted, or stalled are also listed.

You can search the list of results when you click Y (Filter) in a column of interest, then entering a full or
partial run or assay name, or other applicable filter term.

The following run information appears in the Results / Run Results screen.

Column Description
Run Name The unique name of the run given when it was created in the software. Click a run name to
open the Run Summary.
Runs that are reanalyzed are listed with ¢& (Reanalysis) after the run name.
Assay Name The name of the assay selected for the run. You can view the Assay Name and corresponding
Assay Full Name for all assays in the Assays » Manage Assays screen.

70

Oncomine™ Comprehensive Assay v3 GX User Guide




Chapter 8 Review data and results a8

Review run results

(continued)
Column Description
Run Status The status of the run. For example, Analysis In Progress, Executing Plugin, Analysis

Completed, Terminated, Archival: In Progress, Purification In Progress, or Purification
Completed).

Total Samples

The total number of samples in a run.

PCR Plate Number | A unique identifier for the 96-well plate used for library preparation and templating. For more

information, see the software help system.

Started On

The date and time when the run was started.

Updated On

The date and time when the last action was completed on the run.

Users with appropriate permissions can perform the following actions in the Results / Run Results

screen.

Option

Description

Actions | Available action links for a run are shown when you place the pointer over the row of a run. The actions

that are available depend on the type of run.

BAM Uploader—Upload run information to another Genexus™ Software server or to lon Reporter™
Software for further analysis. BAM Uploader is not available for BAM run results or for archived
runs in which BAM files have been removed.

Audit—View the audit trail for the run.
CSA—Download customer support archive (CSA) log files for the run to help with troubleshooting.

Assign PCR Plate—Enter a unique identifier for the 96-well plate used for library preparation and
templating. This action is available only in Sample to Result and Nucleic Acid to Result runs after
the run completes.

Download Files—Select the Variants, Reports, Sequencing Results, Audit and Log, and
Troubleshooting Files to download.

Actions!'! | Available action links for a run are shown when you place the pointer over the row of a run.

View Plan—View detailed run plan information.

Review —Review samples that do not have a concentration within a specified threshold after
purification, but before library preparation.

Abort—Abort a run after purification, but before sequencing. This action is available when the run
status is Purification Review Required, or when the run status is Purification Completed and some
purification samples have been excluded from sequencing.

[ More actions that are available only for Sample to Result runs.
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View the run summary

The run summary provides an overview of the run. The information that is displayed includes the

name of the assay used in the run, sample locations, information about the reagents used in the run,
primer tube positions, and instrument information. Metrics from sample purification are also provided, if
applicable.

1.

2.

In the menu bar, click Results » Run Results.

In the Run Name column, click the run name of interest.

The Run Summary tab opens.

Review the run summary.

Action

Procedure

View the assay metrics.

In the Assays section, click the assay name of interest.

View the sample locations in an image of
a 96-well sample plate.

In the Sample Locations section, click PCR Plate View.

Reanalyze a run with a new assay.

In the upper right corner of the screen, click
-++ (More Options) » Reanalyze.

Run plugins on the sequencing data after
a sequencing run is complete.

In the upper right corner of the screen, click
-+« (More Options) » Run Plugin.

Download customer support archive
(CSA) log files for the run to help with
troubleshooting.

In the upper right corner of the screen, click
-++ (More Options) » CSA.

Upload results to another Genexus™
Software server or to lon Reporter™
Software for further analysis.

In the upper right corner of the screen, click
-++ (More Options) » BAM Uploader.

View the history of variant classifications.

In the upper right corner of the screen, click
+++ (More Options) » Variant Audit.

View the run report.

Click the Run Report tab.

Assign the PCR Plate

72

In Sample to Result and Nucleic Acid to Result workflows, Genexus™ Software allows you to track
and associate a run with the PCR plate used in the run. The PCR plate is the 96-well plate that is used
for library preparation and templating. You can assign a unique identifier, a PCR Plate Number, to runs
that have a status of Library Preparation Completed, Sequencing Completed, or Run Completed.
The PCR plate number that you enter is shown in the Run Results screen and if needed, can help you
track libraries and troubleshoot. Later, if you sequence the remaining libraries in a different sequencing
run and assign the PCR plate number to the run, you can easily search for and find all run results

associated with the libraries in the PCR plate.

1.

2.

In the menu bar, click Results » Run Results.

In the Run Results screen, place the pointer over the row of a run of interest, then click Assign

PCR Plate number.
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In the Assign PCR Plate Number dialog box, confirm, edit, or enter the PCR Plate Number.

The PCR plate number must be between 1 and 10 characters. Only alphanumeric characters
(numbers 0 to 9 and letters A to Z), period (.), underscore (_), or hyphen (-) are allowed. Spaces are
not allowed.

4. Click Submit to associate the PCR plate with the run.

View sample results

1.

2.

3.

Click Results » Sample Results to view sequencing results, including DNA variant and fusion
calls, for a particular sample.

In the Sample Name column, click a sample name.

In the Results screen, click the tabs to view the different types of sample-specific results and data.

Tab

Description

QC

The quality metrics for the sample sequenced in the run. For more information, see “QC results” on
page 74.

Key
Findings

An overview of the results for the sample, including Sample Details, Key Metrics, Key Variants and
Coverage Graphs. For more information, see “Key Findings” on page 76.

Variants

Detailed variant results for SNVs/Indels, Fusions, and CNVs. For more information, see “View
SNV/INDEL results” on page 83, “View Fusion results” on page 86, and “View CNV results” on
page 88.

Plugins

Results generated from the plugins associated with the assay used to analyze the sequenced
sample. For more information, see “Review plugin results in Genexus™ Software” on page 92.

Reports

You can download and generate summaries of run results. There are two types of reports:

* Run Reports - include assay metrics and the record of reagents that were used in a run. For
more information, see “Download a run report” on page 120.

¢ Variant Reports — include the variant results for each sample in a sequencing run, reagents used,
and QC evaluation metrics. For more information, see “Download a variant report” on page 103.

View the QC results

You can view the quality control (QC) metrics for each sample that was sequenced in a run in Genexus™
Software.

To view QC metrics, in the Results / Sample Results screen, click a sample name in the Sample
Name column. In the Results screen, click the QC tab.

For details about QC metrics, see the Genexus™ Software help system.

The QC status for each metric is indicated beneath each QC test (Run QC, Templating Control QC-
CF-1, Sample QC-DNA, Sample QC-RNA and if applicable, Purification QC, NTC QC-DNA, and
NTC QC-RNA).
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QC results
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If a sample fails a single test metric, the sample fails that QC test. A sample must meet all QC
parameter thresholds of a particular QC test in order to pass. The QC status is divided into the following

categories.

o (Passed) indicates the sample passed all QC metrics.

* X (Failed) indicates the sample failed a QC metric.

* — (Not Calculated) indicates a sample did not undergo QC analysis.

Note: If a sample fails to meet one or more QC parameters, you can reanalyze the sample or the run
after adjusting the parameter or parameters. For more information, see “Reanalysis” on page 129.

The data displayed in the screen depend on the assay that was used in the run.

Metric

Description

Purification QC

Quality control information for nucleic acid extraction that is performed on a
Genexus™ Purification Instrument.

Sample Concentration RNA

The concentration of extracted RNA after purification.

Sample Concentration DNA

The concentration of extracted DNA after purification.

Sample Concentration TNA

The concentration of extracted TNA after purification.

Run QC

General run quality control information.

Key Signal

The average signal for library ISPs that identically match the library key (TCAG) after
software processing.

Percent Loading

The number of wells with ISPs divided by the number of the total addressable wells
inarun.

Raw Read Accuracy

The average raw accuracy across each individual base position in a read, where
raw read accuracy is calculated as 100 * (1 - (sum(per base error)/sum(per base
depth))).

Templating QC—CF-1
Control

Sequencing quality metrics of the control fragment. These metrics indicate
templating success.

Average Reads Per Lane

The number of CF-1 reads divided by the number of chip lanes used in the run.

Base Call Accuracy

The probability that a given base is called correctly.

1 — (total number of errors for all positions in CF-1) / (total number of CF-1 base
reads).

Mean AQ20 Read Length (bp)

Average length, in base pairs, at which the accuracy rate is =99% for CF-1 reads.

74
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Metric

Description

Sample QC—DNA

Sequencing quality metrics of the sample DNA library.

MAPD

MAPD (Median of the Absolute values of all Pairwise Differences) is a quality metric
that estimates coverage variability between adjacent amplicons in CNV analyses.
A MAPD value of <0.5 indicates an acceptable level of coverage variability. High
MAPD value typically translates to a lower coverage uniformity. Lower coverage
uniformity can result in missed or erroneous CNV calls.

Mapped Reads

The total valid mapped reads.

Mean AQ20 Read Length (bp)

The average length, in base pairs, at which the accuracy rate is 299% for all aligned
reads of a library.

Mean Read Length (bp)

The average length, in base pairs, of final library reads for the sample.

Read Length Histogram

The histogram presents all filtered and trimmed DNA library reads that are reported
in the output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of genomic sample reads to control reads for each inline control amplicon.

Note: The Read Ratio for each inline control amplicon is expected to be
approximately 3 with 10 ng DNA input for both lon AmpliSeg™ and lon AmpliSegq™
HD chemistries.

Sample QC - RNA

Sequencing quality metrics of the sample RNA library.

Mapped Reads

The total valid mapped reads. That is, the mapped reads that pass the thresholds
and filters across all of the RNA targets in the reference file. This number is a subset
of the mapped reads shown in the Run Samples table in the Assay Metrics. The
minimum Mapped Reads are 20,000.

Mean Read Length (bp)

The average length, in base pairs, of the final library reads for the sample. The
minimum Mean Read length is 60.

Read Length Histogram

The histogram presents all filtered and trimmed library reads that are reported in the
output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

NTC QC - DNA

DNA Sequencing quality metrics of the no template control.

Average Base Coverage
Depth

The average number of DNA reads of all targeted reference bases.

Mean Read Length (bp)

The average length, in base pairs, of final DNA library reads for the no template
control.

Read Length Histogram

The histogram presents all filtered and trimmed reads for the no template control
that are reported in the output BAM file (Y-axis) and the mean read length in base
pairs (X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of no template control sample reads to control reads for each DNA inline
control amplicon.
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Metric

Description

NTC QC - RNA

RNA Sequencing quality metrics of the no template control.

Mapped Reads

The total number of valid mapped reads for the NTC.

Mean Read Length (bp) The average length, in base pairs, of final RNA library reads for the no template
control.
Read Length Histogram The histogram presents all filtered and trimmed reads for the no template control

that are reported in the output BAM file (Y-axis) and the mean read length in base
pairs (X-axis).

Read Ratio for Inline

Spike-ins)

The ratio of no template control sample reads to control reads for each RNA inline

Controls (Endogenous to control amplicon.

View key findings

You can view the Key Findings for a sample starting from either sample results or run results.
In the menu bar:

* C(Click Results » Sample Results, then click a sample name.

* C(Click Results » Run Results, then click a run name to open the Results / Run Results screen. In
the Run Name column, click a run name to open the Results screen, then select a sample from
the Select Sample dropdown list.

Key Findings

The Key Findings table shows details about the sample, a summary of key metrics for the run, and
coverage plots for genes assayed in the run.

Note: The Key Findings table is by default the first view that is first shown for sample results.

Table 7 Sample Details

Section

Description

Sample Name

A unique identifier representing the sample.

Collection Date

The date that the sample was collected.

Gender

The biological sex of the sample: Female, Male, or Unknown.

Sample Type

A term that describes the sample, for example, FFPE, DNA, DNA & RNA.

Application Category

The application type of the sample.

Cancer Type

The type of cancer that is represented by the sample.
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Table 7 Sample Details (continued)

o]

[ €D

Section

Description

Cancer Stage

The stage of the cancer from which the sample was collected.

%_Cellularity

The percentage of tumor cellularity in the sample. This is a whole number between
1 and 100. The % Cellularity attribute is entered when a sample is created. The attribute is
applicable to FFPE samples only. The attribute is shown but not required.

Table 8 Key Metrics

Section

Description

Target Coveragel'l

Target base coverage
at Nx

The percentage of reference genome bases covered by at least N reads.

Amplicon Summary

Average Base
Coverage Depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity Of Base
Coverage

The percentage of bases in all targeted regions (or whole genome) with a depth of
coverage =20% of the mean read coverage. Cumulative coverage is linearly interpolated
between the nearest integer base read depths.

Percent Reads On
Target

The percentage of filtered reads that are mapped to any targeted region relative to all
reads mapped to the reference. A read is considered on target if at least one aligned base

percentage of reads passing uniquely mapped and/or non-duplicate filters, or 100% if no
filters were specified.

overlaps at least one target region. If no target regions (file) was specified, this value is the

[ Metrics are shown only for analyses that run the coverageAnalysis plugin.

The Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer, the genes that are shown in the Key Variants matrix are
determined by the filter chain and the gene list applied to the results. You can change the filters that
are applied to expand or restrict the genes that are shown. For more information, see “View the Key
Variants matrix” on page 78.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.
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View the Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer or Cancer (Germline) the genes that are shown in the
Key Variants matrix are determined by the filter chain and the gene list applied to the results. You can
change the filters that are applied to expand or restrict the genes that are shown.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected

or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.

You can view a color-coded visual summary of variant results in Genexus™ Software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name.

The Results screen opens to the Key Findings tab, which shows the Sample Details, Key
Metrics, the Key Variants, and the Coverage Graphs.

3. Refine the genes that are shown in the Key Variants matrix.

Action Procedure
Hide genes that were not Select or deselect the Not Assayed checkbox.
included in an assay but are in

a gene list.

Refine the genes that are shown

a. Click Edit Filters.
in the Key Variants matrix.

b. To refine or expand the genes, change one or both of the
filters.

® Select a different filter chain or no filter chain.
* Select a different gene list or no gene list.
For more information, see “Search and filter variant results” on
page 82.
c. Click Save.
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SRTestSample®l  c KeyFindings  Variants Plugins

Sample Details

SRTestSample0l 29 APR 2018 Male FFPE Cancer Mon-Small Cell Lung Cancer Primary
Key Metrics
Amplicon Summary

1705 G4 14% 4T .05%%

Key Variants (‘P (? (:P

l Kepvorians Deseceed | | Other Warlarts Dewsed | Mone Desected Bt Rasayed l Not Assayed (4] OncomineVariants (5.14) filter chain and Non-Small Cell Lung Cancer gene list applied Edit Filters

KRAS SNV/indel ALK BRAF EGFR
KRAS €

D

ange: p.Glyl3Asp

MET MTRK2 NTRK3 ERBE2

NTRK1 RET ROS1

Example Key Variants matrix

@ Color coded legend to the variant tile matrix.
Key Variants Detected —A gene is present in the gene list, variants are annotated by the Oncomine™ Variant
Annotator plugin, and the variants are Key Variants. Genes that are called are listed in the Variants tab with Present
in the Call column. Key Variants are listed in the Variants tab, with a value of Yes in the Key Variant column. For
more information about gene lists, see the Genexus™ Software Help.
Other Variants Detected —A gene is present in the gene list and variants are annotated by the Oncomine™ Variant
Annotator plugin, but the variants are not Key Variants. Genes that are called are listed in the Variants tab with
Present in the Call column. Variants that are not Key Variants are listed in the Variants tab, with a value of No in the
Key Variant column.

None Detected —A gene is present in the gene list but no variants are annotated by the Oncomine™ Variant
Annotator plugin.

Not assayed —A gene is present in the gene list, but is not included in the panel used in the assay.
@ Checkbox to hide or show genes that are not assayed.

@ Edit filters —Allows you to select an available filter chain and gene list. Changes of the filter chain or gene list change
the genes that appear in the Key Variants matrix.

@ Variant Name —The name of the variant. The Variant Name is a hyperlink to the pileup for the variant in the
Variants tab.
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View the amplicon coverage

You can view DNA exon amplicon coverage in Genexus™ Software to help you determine whether

the sequencing reads across a gene are uniform and sufficient. The default genes that are shown are
determined by the gene list that is designated as default for the cancer type of the sample. You can also
view amplicon coverage graphs for more genes. These amplicon coverage graphs provide a high-level
overview of coverage. More detailed coverage information is also available in the software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Key Findings tab in the Results screen.
3. Scroll to the amplicon Coverage Graphs.

4. Review the coverage graphs.

5. To show coverage graphs for more genes, scroll to the bottom of the screen. Click Show
Coverage for Gene, then select the gene of interest.

6. You can adjust the amplicon coverage graph with the pointer and the buttons in the upper right
corner of each graph. The coverage graphs change to show coverage for the selected gene.

Action Procedure
Zoom in on a region of interest. Click @ one or multiple times.
Zoom out for an expanded view. Click @ one or multiple times.
Revert to the default view. ¢ (Click @ one or multiple times.
¢ (Click Reset.
Move the image left or right in the screen. | After you zoom in, click-drag at any position in the image.
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Example amplicon coverage graph

Shown here is an example of an amplicon coverage graph for the KRAS gene.

KRAS Coverage

]
Damsy

el
|
D

@ Base coverage is shown on the y-axis on a logarithmic scale.
@ The location of the known hotspots are denoted with gray bars.

@ The location and span of the amplicons are represented with orange bars. You can hover the mouse over an orange
bar to view the amplicon name.

@ The location and span of the transcript track is denoted with green bars. You can hover the mouse over the green bar
to view the exon number.

(® The line along the x-axis is broken to indicate that the graph is discontinuous to show exons.
@ The genome coordinate position is shown on the x-axis.

@ Called variants are indicated with a vertical line above the blue coverage plot. The variants noted in the graph depend
on the filter chain applied to the results in the Key Variants matrix. For more information, see the Genexus™ Software
help system or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

You can place the pointer over the hotspots that are represented with gray lines to view the hotspot name.
@ You can adjust the amplicon coverage graph. For more information, see “View the amplicon coverage” on page 80.

View variant results

You can view detailed variant results in the Variants table. In the default view, all variants are listed.
You can also limit the types of variants that are shown and toggle between different variant results:
SNVs/Indels, Fusions, and CNVs.

Table 9 Variant Tables

Variant type Description

SNVs/Indels| ® SNVs: missense and nonsense single nucleotide variants. Multi-nucleotide variants are
also included.

* Indels: insertion and deletion variants.

Fusions Translocations of genetic material.

CNVs Copy number variations (CNVSs) are variations of the number of copies of a given gene.
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Search and filter variant results

You can search and filter to narrow the list of results that are shown in the variant tables. You can
apply filters to columns of information that appear in the screen. The filters, available at the top of each
column, narrow the list of information in any columns to which filters are applied.

For more information, see the Genexus™ Software 6.8 Help or the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409).

1.

2.

6.

In the menu bar, click Results » Sample Results.

Click a sample name in the Sample Name column.

In the Results screen, click the Variants tab.

Select the variant class to display the results: SNVs/Indels, Fusions, or CNVs.

In the table of variants, in the column heading of 7
interest, click 'Y (Filter). -
* |n the search field, enter at least 3 characters, then click Filter.
* Select the checkbox in the row of each filter that you want to apply, then click Filter.

The options that are available depend on the column and variant class. For example, you can filter
data in the Type column to show one specific variant type.

Click {x] Clear Filters to remove all filters and view the full list of run results.

The column or columns to which you applied a filter change to reflect the filter and selected options.
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System-installed filter chains

The following Genexus™ Software system-installed filter chains are available for use with the
Oncomine™ Comprehensive Assay v3 GX results.

Note: System-installed filter chains are locked and cannot be changed.

System-installed filter
chain

Description

Oncomine™ Variants
(6.8)

This filter chain includes all Oncomine™-annotated variants.

Oncomine™ Extended
(6.8)

Default filter chain that includes all Oncomine™-annotated variants and variants that are
relevant to cancer due to their inclusion in one or more of the following classes.

® CNV variants with FILTER value of GAIN or LOSS.

¢ Likely somatic mutations based on dbSNP, 5000Exomes, EXAC, and UCSC Common
SNPs annotation source databases. The minor allele frequencies range is 0.0 to
1.0E-6. Mutations must also be non-synonymous and occur in exonic or splice-site
regions.

¢ Variants with ClinVar annotations of pathogenic or likely pathogenic.

No Filter Select this option to remove a previously applied filter chain and view all called variants.

View SNV/INDEL results

The SNVs/Indels table lists the calls and other information for the SNV and INDEL variants that are
analyzed in each sample in a run.

To view the SNVs/Indels table for a sample, click Results » Sample Results in the menu bar, then in
the Sample name column, click the name of the sample of interest. Click the Variants tab, then click
SNVs/Indels. To export the data in tabular format, click Export in the upper right corner of the screen.

SNVs/Indels table

The data displayed in the SNVs/Indels table depends on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information, see
“Search and filter variant results” on page 82.

Column Description

User Classifications User-defined classification to select from the list.

For more information, see the software help system, or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

Variant ID The name of the hotspot as defined in the Browser Extensible Data (BED) file.

Click the link to view more annotation information.

Variant Name The name of the variant.
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(continued)
Column Description
Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.
This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.
Locus The chromosome and position of the detected variant.

Oncomine Variant
Class

The type of SNV or INDEL at the locus based on Oncomine™ annotations.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* Gain-of-function—The altered gene product has a new molecular function or pattern
of gene expression compared to the wild-type gene

* Loss-of-function—The altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Gene The gene name.
AA Change Identification of the amino acid change using Human Genome Variation Society (HGVS)
nomenclature.
Ref The reference base or bases at that locus.
Alt The alternate base or bases at that locus.
Type The type of variant that is detected.
* snp (single nucleotide polymorphism)
*  mnp (multi-nucleotide polymorphism)
* ins (insertion)
* del (deletion)
* complex
e FLT3-ITD
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Column Description
Call Indicates the presence or absence of an SNV/Indel variant. When the default filter chain
is applied, only the variant calls that are designated with PRESENT (HOMOZYGOUS) or
PRESENT (HETEROZYGOUS) are displayed in the results table. To view all calls, including
calls that do not pass the required filter thresholds, apply the No Filter option or download
the Variants (VCF) file (see “Results files” on page 100).
¢ PRESENT (HOMOZYGOUS) or PRESENT (HETEROZYGOUS)—Indicates a high
confidence call that passes all filter thresholds at a given variant position.
— When the default filter chain is applied, PRESENT (HOMOZYGOUS,) or
PRESENT (HETEROZYGOUS) indicates the presence of the ALT (alternative)
allele.
— When the No Filter option is applied or when viewing the Variants (VCF) file,
Present does not imply the presence of the ALT (alternative) allele. To infer the
presence of the ALT allele, see the Alt column.
* NO CALL—Although some evidence for the presence of a variant exists, the call does
not pass one or more filters that are required for a high confidence variant call.
e ABSENT—Indicates that the variant is unlikely to be present in the sample.
Call Details The reason why a variant is reported as NO CALL.

Phred QUAL Score

The relative probability of either the "reference" hypothesis interval [0,cutoff], or the
"variant" hypothesis interval [cutoff,1], Phred-scaled (-10*log10). A higher score means
more evidence for the variant call.

Raw Read Depth

Total read coverage across amplicon containing SNV/Indel hotspot locations. Count of
chip-level reads aligned at this locus that participate in variant calling.

Effective Read Depth

The number of reads covering the position.

Alt Allele Read Counts

The number of reads containing the alternate allele.

Coverage

The number of total reads at a locus, wild-type + alt allele.

Nuc Change

The position and identity of the nucleic acid change.

Allele Frequency

The number of variant read counts divided by the total number of read counts for the
sample.

Allele Frequency (%)

The allele frequency, represented as a percentage.

Allele Ratio The relative frequency of each allele.
Mut/WT The ratio of mutant allele to wild-type allele.
Zygosity Describes whether the variant is homozygous (0) or heterozygous (1).

Filtered Read
Coverage

Coverage at the position considering only filtered reads.

Allele read Count

The number of reads detected for the allele. The Allele Read Count filter sets the minimum
count of the genotype alleles.
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Column

Description

Raw Alt Allele Read
Counts

The number of unfiltered reads containing the alternate allele.

PPA Possible Polyploidy Alleles (PPA).
A value of Yes indicates variants that are PPA alleles. A value of No indicates variants that
are not PPA alleles.

P-Value The probability value for the detection of variant calls.

View Fusion results

You can view calls and other information for the fusions that are analyzed for each sample in a run.
To view the Fusions table for a sample, click Results » Sample Results in the menu bar, then in the
Sample name column, click the name of the sample of interest. Click the Variants tab, then click
Fusions. To export the data in tabular format, click Export in the upper right corner of the screen.

Fusions table

The data displayed in the table depend on the assay that was used in the run.

Results in the table can be filtered using filtering tools. For more information, see “Search and filter
variant results” on page 82.

Column

Description

User Classifications

A user-defined classification selected from the list.

For more information, see the software help system, or the Genexus™ Software 6.8 User
Guide (Pub. No. MAN0026409).

Variant ID The name of the fusion target as defined in the BED file.

Key Variant Indicates whether or not the variant is a key variant.
Possible values are Yes or No.
This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus The chromosome positions in the reference genome that define the fusion junction.

Oncomine Variant
Class

Oncomine variant class annotation that indicates fusion type based on Oncomine™
annotations. This information is available if the Apply Oncomine Variant Annotations
checkbox is selected in the assay that is used in the run.
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Column

Description

Oncomine Gene
Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* Gain-of-function—the altered gene product has a new molecular function or pattern of
gene expression compared to the wild-type gene

* Loss-of-function—the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Genes (Exon)

The name of fusion target and representative acceptor and donor exons.

Read Counts

The frequency that the fusion was detected in the sample.

Type

Assay type (for example, Fusion, RNA exon variant (exon skipping), Proc Control).

Call

Indicates the presence or absence of a fusion or RNA exon variant. When the default filter
chain is applied, only the fusion/RNA exon variant calls that are designated with PRESENT
are displayed in the results table. To view all calls, including calls that do not pass the
required filter thresholds, apply the No Filter option or download the Variants (VCF) file (see
“Results files” on page 100).

* PRESENT - indicates a high confidence call that passes all filter thresholds at a given
variant position.

* ABSENT - indicates the absence of a fusion due to a variant call that falls below
thresholds.

* NO CALL - although some evidence for the presence of a fusion exists, the call does
not pass one or more filters that are required for a high confidence fusion call.

Call Details

The reason for reporting a fusion as NO CALL or ABSENT.

Read Counts Per
Million

The number of fusion read counts detected per million total reads.

Oncomine Driver
Gene

The gene believed to be associated with increased oncogenic properties. The gene is
inappropriately activated by the fusion.

Gene Isoform

The name of the fusion target as defined in the BED file.

View RNA Exon Variants

The RNA Exon Variant data view displays a bar graph summary of intragenic exon rearrangements or
fusions. The displayed RNA exon variants are defined in the BED file that is associated with an assay.
The RNA Exon Variant data view is available for all RNA and fusion assays.

1. In the menu bar, click Results » Sample Results.

2. In the Sample name column, click the name of the sample of interest.
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3. Click the Variants tab, then click Fusions.

The Fusions table opens to display fusions results. For more information, see “Fusions table” on
page 86.

4. In the top right corner of the screen, click Visualization » RNA Exon Variant, then review the RNA
Exon Variants plot.

Representative RNA Exon Variant plots

RNA Exon Variants RNA Exon Variants
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The X-axis represents specific exon variants, where each variant is labeled with a gene ID followed by a sequence of adjacent
exons. The Y-axis measures the read counts for each variant, normalized to the wild type.
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@ Example result where only the wild type EFGR (EFGR.EBE7) was detected.

@ Example result where RNA exon 2-7 deletion occurred in the EFGR gene. The deletion of exons 2-7 resulted in an increase of
normalized read counts for the EFGR variant that contains the intragenic fusion of exon 1 and exon 8 (EFGR.E1E8.Del1) and a
decrease of normalized read counts for the wild type EFGR (EFGR.EGE7?).

To return to the table view of fusions, click XX (Remove) next to the Visualization dropdown menu.

View CNV results

The CNVs table lists the calls and other information for the copy number variants (CNVs) analyzed in
each sample in a run.

To view the CNVs table for a sample, click Results » Sample Results in the menu bar, then in the
Sample name column, click the name of the sample of interest. In the Variants tab, click CNVs to
display the data. To export the data in tabular format, click Export in the upper right corner of the
screen.

88 Oncomine™ Comprehensive Assay v3 GX User Guide



CNVs table

Chapter 8 Review data and results ~ [#aie
View sample results

The data displayed in the table depend on the assay that was used in the run.

You can filter the results list in the table using filtering tools and filter chains. For more information, see
“Search and filter variant results” on page 82.

IMPORTANT! (FFPE samples only) If the %Cellularity value for a sample is set to <100, then the
magnitude of copy number gain or loss can be decreased. For more information, see the online help

system.

Column

Description

User Classifications

A user-defined classification selected from the list.

Variant ID

The identifier of the CNV variant.

Click the link to view more annotation information.

Key Variant

Indicates whether or not the variant is a key variant.
Possible values are Yes or No.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus

The starting position of the first amplicon covering the CNV gene.

Oncomine Variant
Class

Annotation that indicates whether CNV is an amplification or deletion.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* Gain-of-function—the altered gene product has a new molecular function or pattern of
gene expression, compared to the wild-type gene

* Loss-of-function—the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Gene

The gene name.

Copy Number

The copy number of a CNV gene locus per genome. This column is available when a
positive call is made.
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Column Description

Call Indicates the presence or absence of a CNV. When the default filter chain is applied, only
the CNV-positive calls that are designated with PRESENT are displayed in the results
table. To view all calls, including calls that do not pass the required filter thresholds, apply
the No Filter option or download the Variants (VCF) file (see “Results files” on page 100).

* PRESENT - indicates a high confidence call that passes all filter thresholds.

e ABSENT - the absence of a variant; result is below the detection threshold for a CNV
call.

* NO CALL- although some evidence for the presence of a variant exists, the call does
not pass one or more filters that are required for a high confidence variant call.

P-Value The statistical significance of the CNV ratio measurement.

Call Details The reason for reporting a CNV as NO CALL.

CNV Confidence The CNV confidence interval associated with the call. The 5% lower confidence bound
value is the ploidy estimate, where there is a 5% chance that the true ploidy is below that
value. The 95% upper confidence bound is the ploidy estimate, where it is 95% certain
that the true ploidy is below that value.

CNV Ratio The ratio of measured CNV gene locus coverage relative to coverage of non-CNV loci.

Med Read Cov Gene |The median read coverage of targeted CNV gene.

Med Read Cov Ref The median read coverage of non-CNV reference loci.

Valid CNV Amplicons | The number of amplicons spanning the CNV call.

Type The type of variant that is detected.

CNV- copy number variant

Compare sample results

In Genexus™ Software, you can compare variant results across samples and create customized
comparison plots. To compare samples from different assays, the research application (such as DNA
or DNA and Fusions) must be comparable. That is, results generated from DNA-only assays cannot
be compared to results generated from RNA-only or fusion-only assays. However, if the results from
a research application include the type of results from another research application, the comparison
can be made. That is, you can compare variant results generated from a DNA and Fusion assay to the
variant results generated from a DNA-only assay.

1. In the menu bar, click Results » Sample Results.

2. Select the checkbox in the row of each sample that you want to compare, then click (% Compare.

Note: Compare is not enabled until at least two samples are selected.

The Results / Compare screen opens and displays a list of variants and variant information in the
Compare Samples table. The Oncomine™ Extended (6.8) filter chain is the default filter chain that
is applied to the data that are displayed in the tables. Only variants with a Variant ID are shown.
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3. In the Compare Samples table, select the checkbox in the row of one or more variants of interest
to view the variants plot (see callout 1 in Figure 1).

4. Customize the variant view if needed.

Option Description
Customize table Click Table Columns, then select the columns that you want to view in the table,
columns or deselect the columns that you want to hide (see callout 2 in Figure 1).
Customize plot Click Chart Options (see callout 3 in Figure 1). In the Preferences dialog box,
axes select the desired X-axis, then select the desired Y-axis for each variant type.

Change the default | From the Filter Chain dropdown list, select a filter that you want to apply to the
filter chain variants that appear in the Compare Samples table (see callout 4 in Figure 1).
For a description of system-installed filters, see “System-installed filter chains”
on page 83.

5. Click Export Variants to download the information in the Compare Samples variant table for the
selected variants.

See callout 5 in Figure 1.
The information is downloaded in XLSX format.

6. Click Download Chart to download the variants plot in PNG format (see callout 6 in Figure 1).

# W1_ciTHA | 20210802 S G, | 20Tr-0807 -3 | 2010808 SHValndets

Ca|pare Samples

rr

Figure 1 Compare variants

@ Select one or more variants to compare in the variants plot.

@ Customize columns that appear in the Compare Samples table.

@ Customize the X-axis and Y-axis that appear in the variants plot.

@ Select a filter chain to filter the results that appear in the Compare Samples table.

@ Download in XLSX format, the information in the Compare Samples variant table for the selected variants.
(8) Download a PNG file of the plot.
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Review plugin results in Genexus™ Software

92

In Genexus™ Software, you can review plugin results in the Results screen for a sample.
Each plugin that was selected for an assay during assay creation is listed in the Plugins tab.

Results / [Runname] v / [Assay name] v /[Sample name] ¥

[Sample name] QC v Key Findings Variants Plugins Reports

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report includes read
statistics and several charts. The statistics and charts that are presented depend on the library type
for the analysis.

The report summary lists the barcode, the sample, the number of mapped reads, the percentage of on
target reads, mean base coverage depth, and base coverage uniformity.

You can download coverageAnalysis plugin output files from the Results screen for a sample. For more
information, see the Genexus™ Software Help.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample of interest.

3. Click the Plugins tab.
A summary table of the coverage analysis, by barcode, is included in the coverageAnalysis
summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.

5. (Optional) Click [§ View Log to view the coverageAnalysis log.

6. (Optional) Click Til Delete to delete the coverageAnalysis plugin output for the selected timestamp.

IMPORTANT! If you click Til Delete, the report is deleted without the appearance of the

confirmation window. Ensure that you intend to delete the report before clicking il Delete.

7. Click --- (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the coverageAnalysis summary pane, in the Barcode Name column, click the link in the row of
the barcode of interest.
The detailed Coverage Analysis Report for the barcode opens in a separate window.
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Reads statistics

The library type determines which statistics are presented. The following tables describe the statistics

that are

generated by the coverageAnalysis plugin. The statistics that are displayed in the report depend

on the type of library that is used in the sequencing experiment. Definitions are in tooltips. Almost every

statistic

, plot, link, and functional widget in the report provides tooltips with definitions. Hover over a

heading or description in the report to view the tooltip.

Table 10 General statistics

Statistic Description
Number of The total number of reads mapped to the reference genome.
:zzzged Note: For Oncomine™ Comprehensive Assay v3 GX, do not use the number of mapped reads from

coverageAnalysis plugin for RNA sample quality assessment. Use the QC results in the Genexus™
Software instead. For more information, see Mapped Reads in Sample QC - RNA in “QC results”
on page 74.

Percent reads
on target

The percentage of filtered reads mapped to any targeted region relative to all reads mapped to the
reference. If no target regions file is specified, this value is the percentage of reads passing uniquely
mapped and/or non-duplicate filters, or 100% if no filters were specified. A read is considered on
target if at least one aligned base overlaps at least one target region. A read that overlaps a targeted
region but where only flanking sequence is aligned, for example, due to poor matching of 5' bases
of the read, is not counted.

Table 11 Amplicon read coverage statistics

The following statistics describe the reads that are assigned to specific amplicons. Each sequence read is assigned to exactly one
of the amplicons specified by the targets file. If a read spans multiple amplicon targets, the target region that the reads covers

most is assigned.

If there is a tie, the target that is the closest to the 3' end is assigned.

Statistic

Description

Number of amplicons | The number of amplicons that is specified in the target regions file.

amplicon reads

Percent assigned The percentage of reads that were assigned to individual amplicons relative to all reads

mapped to the reference. A read is assigned to a particular (inner) amplicon region if any
aligned bases overlap that region. If a read might be associated with multiple amplicons, it
is assigned to the amplicon region that has the greatest overlap of aligned sequence.

amplicon

Average reads per The average number of reads assigned to amplicons.

Uniformity of

amplicon coverage amplicon. Cumulative coverage is linearly interpolated between nearest integer read depth

The percentage of amplicons that had at least 20% of the average number of reads per

counts.

Amplicons with
least N reads

at The percentage of all amplicons that had at least N reads.
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Amplicon read coverage statistics (continued)

Statistic

Description

Amplicons with no
strand bias

The percentage of all amplicons that did not show a bias towards forward or reverse
strand read alignments. An individual amplicon has read bias if it has =10 reads and the
percentage of forward or reverse reads to total reads is greater than 70%. Amplicons with
<10 reads are considered to have no strand bias.

Amplicons reading
end-to-end

The percentage of all amplicons that were considered to have a sufficient proportion of
assigned reads (70%) that covered the whole amplicon target from 'end-to-end'. To allow
for error, the effective ends of the amplicon region for read alignment are within 2 bases of
the actual ends of the region.

Amplicon base
composition bias

A number that represents the proportion of amplicons showing low representation (<0.2x
mean reads) in the lower and/or upper quartiles of amplicons ordered by increasing GC
base pair content of their insert sequences. The value is relative to that in the center 50th
percentile of amplicons and weighted by the standard deviation of representation over all
amplicons. An RMS (root mean square) value is used so that a bias greater in either upper
or lower quartiles produces a larger value than a mean bias seen more equally in both outer
quartiles. The value is 0 if the uniformity of amplicon coverage metric is 100%, however, the
value is not necessarily high at lower amplicon uniformity.

Table 12 Target base coverage statistics

The following statistics describe the targeted base reads of the reference. A base covered by multiple target regions is counted
only once per sequencing read.

Statistic

Description

Bases in target
regions

The total number of bases in all specified target regions of the reference.

Percent base reads on
target

The percent of all bases covered by reads aligned to the reference that covered bases in
target regions. Clipped bases, deletions, and insertions (relative to the reference) are not
included in this percentage.

If no specific target regions were specified, the whole genome is the targeted regions.

Average base
coverage depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity of base
coverage

The percentage of bases in all targeted regions (or whole genome) that is covered by
at least 20% of the average base coverage depth reads. Cumulative coverage is linearly
interpolated between nearest integer base read depths.

Target base coverage
at Nx

The percentage of target bases covered by at least N reads.
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Table 12 Target base coverage statistics (continued)

Statistic Description

Target bases with no | The percentage of all target bases that did not show a bias toward forward or reverse
strand bias strand read alignments. An individual target base is considered to have read bias if it has

>10 reads and the percentage of forward or reverse reads to total reads is greater than
70%. Target bases with <10 reads are considered to have no strand bias.

reads

Percent end-to-end The percentage of on-target reads that fully cover their assigned amplicon (insert) from

‘end-to-end'. To allow for error, the effective ends of the amplicon region for read alignment
are within 2 bases of the actual ends of the region.

Example charts generated by the coverageAnalysis plugin

The charts that are generated by the coverageAnalysis plugin include Plot, Overlay, or Display menus
that allow you to customize the data that is displayed in each chart.

Click Q (Search) (in the top right corner of a chart) to open the chart Viewing Options panel, where
you can further customize a chart. Click ? (Help) to open a description of the chart.

~ Depth of Coverage Chart IPIot: Maximum Read Depth ¥ I Zoom Out) ? P

Viewing Options: Automatic Zoom: # Show Legend: ¢ Include Ox Coverage: ¥ Bin Size: 1000

40% 100%
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Cumulative Bases 80%

U
2
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0 10000 20000 30000 40000 50000 60000 70000 80000 90000

Base Read Depth

A

Figure 2 Representative Depth of Coverage Chart The Depth of Coverage Chart shows the distribution of
targeted base coverage. The X-axis represents the base read depth. The left Y-axis represents the number of reads at a
given base read depth or a range (bin) of base read depths, as a percentage of the total number of base reads. The right
Y-axis represents the cumulative count of the number of reads at a given read depth or greater, as a percentage of the
total number of reads. The individual orange bars represent the percentage of reads in the specific range of base read
depths. The blue curve measures the cumulative reads at a given base read depth or greater. If your analysis includes

a region of interest file, this chart reflects only target regions (reads that fall within a region of interest). Use the Plot
dropdown list to switch between Maximum Read Depth, 99.9% of All Reads, and Normalized Coverage plots.
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Representation Plots Display: Pass/Fail vs. Target G/C Content v

Amplicon Representation vs. Amplicon C/G Content

@ Pass/Over (Assigned Reads >= 5x mean)
W Pass

B Fail (Assigned Reads < 0.2x mean)

m Drop Out (0 Assigned Reads)

Number of Amplicons

22 24 2% 28 30 32 34 36 38 40 42 a4 46 4B 50 52 54 56 58 60 62 64 66 68 70 72 74 76

Amplicon C/G Base Content (%) .

Figure 3 Representation Plots Use the Display dropdown list to switch between Pass/Fail vs. Target G/C Content,
Pass/Fail vs. Target Length, Representation vs. Target G/C Content, Amplicon Coverage Chart, Mean Target Reads
vs Pool, Reference Coverage Chart, and Representation vs. Target Length plots. This figure shows an example
Pass/Fail vs. Target G/C Content plot.

Output files generated by the coverageAnalysis plugin

You can download coverageAnalysis plugin results files from the Results screen for a sample. For more
information, see “Results files” on page 100.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™ Excel™. To
resolve this problem, right-click the file and click Save As to rename the downloaded file.

The following tables describe the files that can be generated by the coverageAnalysis plugin. The list of
files depends on the application type that was selected during assay creation.

Table 13 File download selections in the Genexus™ Software

Selection File Name
DNA Coverage Statistics <DNA Barcode><ExpName>.stats.cov.txt
DNA Chromosome base coverage summary <DNA Barcode><ExpName>.chr.cov.xls
DNA Base depth of coverage <DNA Barcode><ExpName>.base.cov.xls
DNA Amplicon coverage summary <DNA Barcode><ExpName>.amplicon.cov.xls
DNA Coverage Analysis Summary (.pdf) <DNA Barcode><ExpName>.summary.pdf

Table 14 File contents

File Description
Coverage A summary of the statistics presented in the tables at the top of the plugin report. The first line is
Statistics the title. Each subsequent line is either blank or a particular statistic title followed by a colon ()
and its value.
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Table 14 File contents (continued)

File Description
Chromosome Base reads per chromosome summary data that is used to create the default view of the
base coverage Reference Coverage Chart. This file contains the following fields.
summary .

[ )

()

chrom: the name of the chromosome or contig of the reference.

start: the coordinate of the first base in this chromosome. This is always 1.

end: the coordinate of the last base of this chromosome. Also its length in bases.

fwd basereads: the total number of forward strand base reads for the chromosome.
rev_basereads: the total number reverse strand base reads for the chromosome.

fwd trg basereads (if present): the total number of forward strand base reads that
mapped over at least one target region.

rev_trg basereads (if present): the total number of reverse strand base reads that
mapped over at least one target region.

total reads: the total number of sequencing reads that are mapped to individual
contigs.

Base depth of
coverage

Coverage summary data used to create the Depth of Coverage Chart. This file contains the
following fields.

read depth: the depth at which a (targeted) reference base has been read.

base cov: the number of times any base was read (covered) at this depth.

Note: Lines (read depths) for which base cov is 0 are omitted to avoid excessively large
files being produced in specific situations.

base cum_cov: the cumulative number of reads (coverage) at this read depth or greater.

norm read depth:the normalized read depth (depth divided by average base read
depth).

pc_base cum_cov:same as base_cum_cov but represented as a percentage of the total
base reads.
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Table 14 File contents (continued)

File Description
Amplicon Coverage summary data used to create the Amplicon Coverage Chart. This file contains the
coverage following fields:
summary .

contig_id:the name of the chromosome or contig of the reference for this amplicon.
® contig_srt:the start location of the amplicon target region.
Note: This coordinate is 1-based, unlike the corresponding 0-based coordinate in the
original targets BED file.
* contig end: the last base coordinate of this amplicon target region.

Note: The length of the amplicon target is given as tlen = (contig_end - contig_srt + 1).
* region_id:the ID for this amplicon as given as the fourth column of the targets BED file.

®* gene_ idorattributes: the gene symbol or attributes field as provided in the targets
BED file.

® gc_count:the number of G and C bases in the target region. The %GC that is uses this
count divided by the amplicon (insert) length.

* overlaps: the number of times this target was overlapped by any read by at least one
base.
Note: Individual reads might overlap multiple amplicons where the amplicon regions
themselves overlap.

* fwd e2e:the number of assigned forward strand reads that read from one end of the
amplicon region to the other end.

* rev_eZ2e:the number of assigned reverse strand reads that read from one end of the
amplicon region to the other end.

* total reads: the total number of reads assigned to this amplicon. This value is the sum
of fwd_reads and rev_reads and is the field that rows of this file are ordered by (then by
contig id, srt, and end).

¢ fwd reads: the number of forward strand reads that are assigned to this amplicon.
* rev_reads: the number of reverse strand reads that are assigned to this amplicon.

* covNx: the number of bases of the amplicon target that had at least N reads. There are
3 such columns for the specified coverage tiers, which by default are cov20x, cov100x,
and cov350x.

Coverage A PDF file that contains the Coverage Analysis Report, including read statistics and charts that
Analysis are generated by the coverageAnalysis plugin.
Summary (.pdf)

Review samplelD plugin results in Genexus™ Software

After the sequencing run completes, review the plugin results.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample of interest.
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4.

5.

Click the Plugins tab.

Chapter 8 Review data and results ~ [#aie
View sample results

A summary table of the samplelD results is shown.

Click a barcode name to open the Sample ID Report.

To return toGenexus™ Software, click back in the browser.

Download results files for a sample result

You can download results files for a sample result in Genexus™ Software.

1.

2.

In the menu bar, click Results » Sample Results, or Results » Run Results, then do one of the

following procedures.

Option

Selection

Download files for a sample

Download results files for a
sample from the list of sample
results.

In the Results / Sample Results screen, place the pointer over the row
of a sample of interest, then click Download Files.

Download results files for a
selected sample from the
Results screen.

1. In the Results / Sample Results screen, in the Sample Name
column, click the sample name of interest.

2. Click -+ (More Options) » Download Files.

Download files for a run or assay

Download results files for a
run from the list of run results.

In the Results / Run Results screen, place the pointer over the row of
a run of interest, then click Download Files.

Download results files for a
selected run or assay from the
Results screen.

1. In the Results / Run Results screen, in the Run Name column,
click the run name of interest.

2. Click the run or assay of interest from the results navigation bar.
3. Click -+ (More Options) » Download Files.

In the Download Files dialog box, select the files to download, then click Download.

For information about the files, see “Results files” on page 100.

The selected results files are downloaded in one ZIP folder.
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View sample results

The following files can be downloaded from the View Results screen for each sample. The files that are
available for download vary depending on the assay used. Results files include the sequencing data,
results from the analyses, such as variant files, and audit and log files. For a list and descriptions of
plugin output files, see the Genexus™ Software Help.

Option

File name

Description

Variants

Filtered Variants
(.vef)!!

<Filter name> filtered.vcf

Summary of filtered variant results in variant
call format (VCF).

All Variants (.vcf)!']

Oncomine <LibPrepID>
<analysisID>.vcf

Summary of variant results in variant call
format (VCF).

Snvindel (.tsv)

Snvindel.tsv

File that lists SNV/INDEL variant results in tab-
separated value format (TSV).

Fusion (.tsv)

Fusion.tsv

File that lists fusion results in tab-separated
value format (TSV).

File (.bam)

_rawlib.basecaller.bam

CNV (.tsv) Cnv.tsv File that lists copy number variant results in
tab-separated value format (TSV).

Sequencing Results

DNA Unmapped Bam | <barcode> Unmapped DNA barcode BAM file; output

after mapping reads to reference.

DNA mapped bam
file (.bam)

merged.bam

Mapped BAM file of combined barcode reads.

DNA Mapped Bam
Index File (.bai)

merged.bam.bai

Mapped BAM Index file.

DNA Basecaller
FASTAQ File (.fastq)

<barcode> rawlib.
basecaller.fastqg

FASTQ file of the DNA barcodes used.

DNA Processed Bam
File

merged.bam.ptrim.bam

Mapped BAM file of combined barcode reads.

DNA Processed Bam
Index

merged.bam.ptrim.bam.bai

Mapped BAM index file.

RNA Unmapped Bam
File (.bam)

<barcode> rawlib.
basecaller.bam

Unmapped RNA BAM file; output of base
calling, contains unmapped reads.

RNA Mapped Bam
File (.bam)

<barcode> rawlib.
basecaller alignments.bam

Mapped BAM file of combined barcode reads.

RNA Mapped Bam
Index File (.bai)

<barcode> rawlib.
basecaller alignments.bam.bai

Mapped BAM index file.
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(continued)
Option File name Description
RNA Basecaller <barcode> rawlib. FASTQ file generated from the unmapped
FASTAQ File (.fastq) |basecaller.fastqg BAM file of the RNA barcodes used.
Test Fragment rawtf.basecaller.fastqg FASTQ file for the test fragment.
Basecaller FASTAQ
File (.fastq)

Audit and Log

Analysis Log File analysis.log Analysis log file.

Run Summary?! Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Run Audit PlannedRun-AuditTrail.pdf Contains all audit records pertaining to the
run.
Reports
Report <language> <sampleName> <mode> |A PDF report that contains sample-specific
_<templateName> <assayName> results. For more information, see “Variant
<date>.pdf report” on page 102.
Sample Summaryt®! Info.csv Contains information about the run and

analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.

Troubleshooting Files

Log Filesl¥ analysis.log Analysis log file.

summary.<timestamp>.log Start and end time for each time an assay
module is executed for the analysis.

various.err Analysis pipeline logs used by field service

. engineers for troubleshooting.
various.out

Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics, and
instrument summary.
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Variant report
(continued)
Option File name Description

Log Filesl4 PlannedRun-AuditTrail .pdf Contains the audit trail of the run plan in PDF
format.

Otherl¥ analysis.ini Analysis configuration files, including

analysisSamples.3son secondary and tertiary INI files.

VCF Files analysis.vcf Summary of variant results in variant call

format (VCF).

' You can view the extracted files individually, or upload a VCF file to a software application that accepts VCF files, such as lon
Torrent™Oncomine™ Reporter software.

[ Files are available only for assays from Genexus™ Software version 6.2 and earlier.
Bl Files are available for both custom and system installed assays in Genexus™ Software version 6.6.
¥ Separate folders are generated for each sample. If included in the run, separate folders are also generated for an NTC and positive control.

Variant report

A variant report is a PDF report of the results for each sample in a sequencing run. You can use
a system-installed report template. For system installed report templates, the assay used in the run
determines the data that are included in the report.

Alternatively, you can customize the layout and contents of a variant report.

To automatically generate a variant report for each sample during data analysis of a run, enable
Generate Report in the Setup step when you plan the run (for more information, see Chapter 4, “Plan
and manage runs”). Alternatively, if you did not enable this feature, you can generate a variant report for
each sample after a run is complete. For more information, see the software help system.

When a variant report has been generated for a sample, it is available for download in two places:

* Alink is available in the Results / Sample Results screen when you place the pointer over the row
for that sample. Click the link to download the PDF.

¢ A Download Report button is available in the Variant Report pane in the Reports tab.
Variant reports can be electronically or manually signed by users. Electronically signed reports have
[Z (Sign off) after the sample name in the Sample Results screen. The electronic signature is included
in the footer of the report. If included, electronic signatures also appear in the Electronic Signature

section of the report. A sample name followed by & (Locked) indicates that the variant report is
locked. For more information, see “Sign off on the run results” on page 103.

For more information about variant reports and report templates, see the software help system.
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Variant report

Download a variant report

You can download a variant report for a sample result of interest from the Results / Sample Results
screen.

Note: The variant report is also available for download as part of the results files in the Results screen
for a specific sample. For more information, see “Results files” on page 100.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, place the pointer over the row of the sample of interest, then click
Report.

Non Archived ~ Selected Samples: 0

Sample Name T Assay Name Run Name T Sample Status b ¢ QC Status I

& 3 DNA Fus w LibSample1_2021-07-09- 73044

A ZIP file that contains the PDF report downloads automatically.

3. Extract the downloaded files, then open the PDF file in an appropriate viewer.

Sign off on the run results

Multiple users can sign variant reports. In the Results / Sample Results screen, a sample name
followed by [ indicates that the sample results are signed off by at least one user. A sample name
followed by & indicates that the variant report is locked. After a variant report is locked, the report

is no longer available to be signed by any other user. The signature information appears in the variant
report PDF file. For more information, see “Variant report” on page 102.

Multilanguage support for PDF report generation is provided.

This feature allows you to meet Title 21 CFR Part 11 of Federal Regulations that establishes the
United States Food and Drug Administration regulations on electronic records and signatures, password
policies, and user activity auditing.

Permission to sign reports must be enabled in order to sign reports. An administrator-level user
manages electronic signature permissions for user accounts. For more information, see the software
help system.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample result of interest.
3. In the upper right corner of the screen, click --- (More Options) » Sign Off.

4. In Password, enter the password.

5. In the Electronic Signature dropdown list, select the meaning of the signature.
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6. In the Report Template dropdown list, select the report template that you want to use.

The option to select the report template is available only before the variant report has been signed
by any user.

7. In Sign Off Comments, enter a comment.

8. In Report Name, change the name of the report if needed.

The option to change the report name is available only before the variant report has been signed
by any user.

9. In Select Your Language, change the language of the report if needed.

The option to change the language is available only before the variant report has been signed by
any user.

10. In Footer Field, enter any text that you want to appear in the footer of the PDF report pages.

If you entered footer information in the Footer Field when you created a report template, the
same footer information appears in the Electronic Signature dialog box. You can enter new footer
information to override the report template.

11. Click Sign Off to confirm the electronic signature.

The report is signed. If the signature is designated to lock the report, the variant report is signed and
locked.

For information to download the signed report, see “Download a variant report” on page 103.

Example metrics for a successful Oncomine™
Comprehensive Assay v3 GX sequencing run

104

The following table summarizes typical QC metric values that are obtained from successful sequencing
runs. The QC metric values in the table are recommendations and not absolute thresholds. Sequencing
runs with values below those specified in the table may still be acceptable, but require more scrutiny.
For help, contact support.

IMPORTANT! Actual QC threshold values can be viewed by clicking on the assay name in the Assays
» Manage Assays screen. To edit the QC threshold values, see “Edit the QC parameters of an assay”
on page 121.

Table 15 Example QC metrics for successful sequencing runs

QC metric Value
Run QC
Key Signal =55
Percent Loading =75%
Raw Read Accuracy >98%
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Table 15 Example QC metrics for successful sequencing runs (continued)

o]

| D]

QC metric Value
Templating QC - CF-1 Control
Average Reads Per Lane =400
Sample QC - DNA
Mapped Reads >3,000,000
Mean Read Length (bp) =75
Uniformity Of Amplicon Coverage >85%
Sample QC - RNA
Mapped Reads >200,000
Mean Read Length (bp) =60
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Troubleshooting

Genexus™ Integrated Sequencer—general and QC

troubleshooting

Observation

Possible cause

Recommended action

A consumable is not recognized by the
sequencer after loading on the deck

The consumable (for
example, a strip, pipette
tip box) is correctly
placed but is not
completely inserted into
its position, causing it
to be misaligned with its
expected position.

Ensure that the consumable is pressed
completely into place. Apply firm
pressure on the item so that it fits snugly
into its deck position.

The barcode of the
consumable is not
readable by the
instrument.

Tap Help in the lower left corner of the
Load Instrument screen and follow on-
screen instructions to override the block
manually. Note that the name of the
consumable does not appear in the list
of consumables in the run summary.

If the behavior continues in subsequent
runs, contact Technical Support.

Consumable version
does not match the
Genexus™ Software
version. For example, a
consumable compatible
with Genexus™ Software
6.6 is installed in a
sequencer updated for
Genexus™ Software 6.6.

Ensure that you are using consumables
compatible with the software installed
on the sequencer.

Run Status = Failed

Details: In the Genexus™ Software Run
Result screen, the Run Status for a
completed run is listed as "Failed". In
the Sample Results screen, the Sample
Status is listed as "BaseCallingActor
FAILED".

Chip calibration failed
due to a chip problem, or
an instrument problem.

Repeat the run with a new chip. If
the problem persists, contact Technical
Support.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

A lane that has been used is not crossed
out in the sequencer screen

Details: After completion of a run, the lane
used in the run was not crossed out, so
that the next run could reuse the lane.

A chip problem caused a
datacollect failure to read
efuse.

In the sequencer screen, tap

Settings » Clean instrument to perform
a clean instrument. After cleaning, start
anew run.

Note: The Clean instrument procedure
renders remaining sequencing reagents
and unused lanes on the installed chip
unusable in a sequencing run after the
cleaning.

The number of sample reads is low, CF-1
metrics pass QC, but read ratio of inline
controls is low

Details: If CF-1 reads per lane, accuracy,
and mean AQ20 read length are good, and
read ratio of inline controls (endogenous
vs. spike-in) is low (<< ~3), a problem

with sample input is indicated. For more
information, see “Troubleshoot Genexus™
Integrated Sequencer performance with
CF-1 and inline controls” on page 109.

Nucleic acid input may
have been insufficient,
and/or the nucleic acid
was degraded.

For a sample run, requantify nucleic acid
samples and/or perform sample QC to
ensure that the expected nucleic acid
input and size was loaded.

If needed, reisolate and purify nucleic
acid samples.

The number of sample reads is low, but
CF-1 metrics pass QC, and read ratio of
inline controls is normal

Details: If CF-1 metrics passed QC, and
read ratio of inline controls is normal
(~~3), a problem in library preparation
unrelated to sample input or quality

may be indicated. For more information,
see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 109.

One or more of the
Genexus™ Strip 1 strips
used in the run had
magnetic beads trapped
in the tube 5 keyhole.

Repeat the run with strips that you
have verified have no trapped beads.
For more information, see “Before you
begin” on page 59.

An incorrect assay was
selected for the run,

or library amplification
parameters were not
optimal.

Ensure that you have selected the
correct assay and reviewed assay
parameters.

Library strips were
inadequately equilibrated
to room temperature
(Genexus™ Strip 1),

or incompletely thawed
(Genexus™ Strip 2-AS or
Genexus™ Strip 2-HD)
before loading in the
sequencer.

Ensure that Genexus™ Strip 1 strips are
fully equilibrated to room temperature,
and Genexus™ Strip 2-AS strips are
completely thawed before loading in the
sequencer.

The number of sample reads is low, and
CF-1 metrics fail QC

Details: If CF-1 metrics failed QC, a
problem in templating or sequencing

is indicated. For more information,

see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 109.

One or more of the
Genexus™ Strip 3-GX5™
strips used in the

run may have had an
excessive amount of
magnetic beads trapped
in the tube 6 or

7 keyhole.

Repeat the run with strips that you
have verified have no trapped beads.
For more information, see “Before you
begin” on page 59.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

The number of sample reads is low, and
CF-1 metrics fail QC

Details: If CF-1 metrics failed QC, a
problem in templating or sequencing

is indicated. For more information,

see “Troubleshoot Genexus™ Integrated
Sequencer performance with CF-1 and
inline controls” on page 109.

(continued)

Template strips were
inadequately equilibrated
to room temperature
(Genexus™ Strip 3-GX5™),
or incompletely thawed
(Genexus™ Strip 4) before
loading in the sequencer.

Ensure that Genexus™ Strip 3-GX5™
strips are fully equilibrated to room
temperature, and Genexus™ Strip 4
strips are completely thawed before
loading in the sequencer.

The sequencing chip or
coupler was defective or
leaky.

Repeat the run with new chip and
coupler. If low performance continues,
contact Technical Support.

The run was started
>14 days after the

last initialization was
performed, or on an
expired initialization.

Perform a Clean instrument procedure
(Settings » Clean instrument). For
more information, see the Genexus™
Integrated Sequencer User Guide. After
the Clean instrument procedure, install
new a chip, and new sequencing
reagent bottles and cartridge in the
sequencing reagents bay, then repeat
the run.

Note: Reagents are stable on

the sequencer for 14 days, after

which you may experience decreased
performance. For more information, see
Appendix A: Troubleshooting in the
Genexus™ Integrated Sequencer User
Guide (Pub. No. MAN0017910).

An Oncomine™ Comprehensive Assay v3
GX DNA and Fusion run fails the QC
threshold for the MAPD parameter due to
a decrease in mean read length (MRL) of
DNA pool 2.

At high temperatures
(within instrument
specifications), the
Genexus™ Integrated
Sequencer PCR block
is susceptible to
temperature variation in
the lower, middle area
of the cycler block. This
variation can affect assay
performance.

A reduction from 99°C to 98°C for
both the activation and denaturation
steps in the library preparation

target amplification PCR profile for
lon AmpliSeq™ Assays results in a
more consistent library preparation
performance, which in effect also
produces more stable and predictable
sequencing results. Contact your field
service representative to obtain the ADF
package (version w6.0.2 or later) that
contains these temperature settings.
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Appendix A Troubleshooting
Troubleshoot Genexus™ Integrated Sequencer performance with CF-1 and inline controls

Troubleshoot Genexus™ Integrated Sequencer performance
with CF-1 and inline controls

You can use quality control results to troubleshoot Genexus™ Integrated Sequencer runs to help identify
the cause of performance problems. If you select the Include Inline Controls checkboxes for DNA

and RNA in the Reagent step when you create an assay, you include the inline control analysis in

the post-run results analysis. Inclusion of a set of six control amplicons (covering a range of amplicon
length) and spike-in nucleic acid into sample library preparation reactions helps determine whether poor
performance is due to insufficient sample input and/or poor sample quality, or is unrelated to sample
input and quality. With 10 ng sample input, the read ratio of endogenous sample reads to spike-in
control reads is expected to be ~3. Using more than 10 ng sample input results in a proportionally
higher read ratio. For example, if you load 20 ng of sample, the read ratio should be ~6.

The CF-1 templating control serves as a check on templating and sequencing performance that is
independent of library preparation.

Use the following table as a guide to help identify the source of performance problems. For
recommended actions, see the troubleshooting topics under “Genexus™ Integrated Sequencer—
general and QC troubleshooting” on page 106.

Run diagnostic

QC category Sample input Library preparation Templating or
Successful run and/or quality problem unrelated to Sequencing
problem sample problem
Sample QC (endogenous Passed Failed Failed Failed

sample reads)

Read ratio for inline controls Normal Low Normal or variable —
(endogenous to spike-in reads) | Read ratio ~3 Read ratio <<3

Templating Control QC - CF-1 Passed Passed Passed Failed

Genexus™ Software

Observation Possible cause Recommended action
Cannot sign in You have either forgotten Contact the Genexus™ Software system administrator.
to the Genexus™ your password or are
Software signed out due to several
failed login attempts.
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Genexus™ Software

Observation

Possible cause

Recommended action

Batch sample
import fails

One or more entries

in the sample-import
spreadsheet contains
special characters, lines
breaks, unexpected
spaces, incorrect entry
length, incorrect date
formatting, or other
formatting errors.

Check each entry for correct formatting, correct any errors,
and repeat the import.

Blank rows were copied
into the sample-import
template file from a
different source.

Rows that appear empty can contain hidden formatting that
conflicts with the import function. Start with a clean sample-
import template file, and be careful to copy only those rows
that contain actual data.

The sample import
spreadsheet contains a
nonunique sample name.

Every sample name in the software must be unique. Ensure
that the spreadsheet does not contain any duplicate sample
names, then repeat the import. Note that the system check is
not case-sensitive, so a sample name of ABC1 conflicts with
abc1.

The headings in

the sample import
spreadsheet do not match
the sample attributes in
the software.

The headings must match the sample attributes in the
software exactly. Check the headings for spelling or other
errors.

Map a sample attribute if needed.

Cannot upload my
panel or hotspots

Issues with BED file
format or files do not end
in.bed.

Ensure your file is in the correct BED format and has a .bed
extension.

Variants tab is
missing hotspot
entries

Details: The
remaining entries
are present.

Hotspot BED file contains
entries that are incorrectly
formatted.

Check that BED file entry is correctly formatted. See the
following examples:

SNP entry: chr1 2337276 2337277 SVA_322 0 +
REF=C;0OBS=T;ANCHOR=G AMPL

Deletion entry: chr1 201341175 201341180 SVA_497 0 +
REF=AGAAG;OBS=;ANCHOR=C AMPL

Insertion entry: chr1 236978992 236978992 SVA_621 0 +
REF=;0BS=TCTG;ANCHOR=T AMPL

Ensure that the REF values match the actual reference
coordinate of hg19.

No information for
my loci of interest in
the results

The wrong hotspot or BED
file is associated with the
assay.

1. Check the hotspot and BED files associated with the
assay. If either is incorrect, create a new assay.

2. Plan a new run for the sample or sample library with the
correct assay.

3. Repeat sequencing of the sample or sample library.

The results of the
run do not appear
in the Results / Run
Results screen

The instrument disk space
is full.

Clear disk space on the sequencer. For more information, see
"Manually delete run data" in Genexus™ Integrated Sequencer
User Guide (Pub. No. MANOO17910).
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Genexus™ Software

Observation Possible cause Recommended action
Cannot download The run failed. Create an assay with the correct configuration for the samples,
run result files then reanalyze the samples.
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Working with samples

System-installed sample attributes

The following table lists and describes system-installed sample attributes. System-installed sample
attributes cannot be edited.

Note: Custom sample attributes are not listed in this table.

Sample attribute Description

Sample Namel'l | A unique identifier representing the sample.

The sample name can contain only alphanumeric characters (0-9, Aa-Zz), periods (.),
underscores (_), or hyphens (-), cannot contain spaces, and is limited to a maximum of
20 characters.

IMPORTANT! To prevent erroneous sample selection during run planning, ensure that you
assign a unique and distinguishable sample name for each sample.

Note:
. Samples that have been used in a run cannot be deleted.

. To prevent duplication, the software checks all sample names and returns an error message if
a non-unique sample name is detected.

Collection Datel'l | The date that the sample was collected.

Click [ Calendar to select the date in the correct format.
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(continued)
Sample attribute Description
Gender!'! The biological sex of the sample: Female, Male, or Unknown.

IMPORTANT! Male or Female must be selected for correct measurement of AR CNV.

Sample Typel'l A term that describes the sample, for example, FFPE, DNA, DNA & RNA. You can also select
Other, then enter a custom sample type.

Nucleic Acid The sample nucleic acid type, such as DNA, RNA, or TNA.

Type

Application The sample application category, such as Cancer (Germline) or Solid Tumor.
Category!']

Note: If you select an oncology application category in this list, the Cancer Stage, Cancer
Type, % Cellularity, and % Necrosis attributes listed below become available in the Add New
Sample dialog box.

Cancer Typel'l The type of cancer that is represented by the sample.

Select the type of solid or hematologic cancer. If cancer type is unknown, select Unknown
Primary Origin.

Cancer Stagel'! | The stage of the cancer from which the sample was collected.

Select Stage 0-1V, or Primary, Unknown, or Other.

% Cellularity The percentage of tumor cells over normal cells in the sample. This is a whole number between
1 and 100. The % Cellularity attribute is applicable only to FFPE samples.

IMPORTANT!

. If this value is not set, % Cellularity is assumed to be 100% in calculations that use this
attribute.

« % Cellularity is a required attribute for CNV analyses. Do not leave the field blank.

. (FFPE samples only) If % Cellularity value is set to <100, then the magnitude of copy
number gain or loss can be decreased. For more information, see the Genexus™ Software

Help.
% Necrosis The percentage of cellular necrosis in the sample. This is a whole number between 1 and 100.
Notes An open-entry field for more sample information.

' Required attribute
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Import samples

114

You can enter sample information for multiple samples directly in Genexus™ Software. When you want
to create more than a few samples, an easy and fast way to add multiple samples in the software is to
create a file of information for a group of samples and import that file.

Sample data files can be used to capture, manage, and edit sample data. You can import sample data
files in TSV, XLS, XLSX, or CSV file formats. For a list of the sample attributes that are included in the
import file, see the Genexus™ Software Help. For ease of use, you can download a Microsoft™ Excel™
template file to create an import file.

1.

2.

In the menu bar, click Samples » Create Sample.

In the Create Sample screen, click the Multiple (.xls, .csv, .tsv) tab.

In the Application Category dropdown list, select the application category for the samples.

Tip: Use the search field to search for the application category of interest.

Set up a sample file using one of two options.

Option Description
Download a template For more information, see the software help system, or the Genexus™
file, then edit it to create | Software 6.8 User Guide (Pub. No. MAN0026409). Upload the edited file
a new file. using the Browse button.

Note: When you select Other as the Application Category, you must
enter text in the Application Category text box, then click anywhere in the
screen in order for the template file to be available.

Upload the sample data
from an existing file.

a. Click Browse.
b. Navigate to the file, then click Open.

The data contained in the file populates the table in the screen.

In the sample file, edit the sample table and data, if needed.

Option

Description

Remove an attribute column.

Click Columns, then deselect the column name.

Add an attribute column to the
table.

Click Columns, then select the column name. The column names
that are listed are Application Category-specific.

Edit sample data.

Click the sample row of interest, then edit the text field or
dropdown list for the sample.

Add more samples to the table.

Click Add Row, then enter the sample data.

Remove a sample from the table.

Select the checkbox for the row, then click Remove Row.
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6. Select the checkbox in the row for each sample to create. To select all samples, select the
checkbox in the column heading row.

IMPORTANT! The information for samples that are not selected is not retained by the software.
Ensure that you select the checkbox for every sample you intend to create.

7. Click Save.
You can place the pointer over (%) (alert) to view more information if needed.

The new samples are listed in the Manage Samples screen and are available to assign to a run plan.

Guidelines for Oncomine™ Comprehensive Assay v3 GX

settings

In the Genexus™ Software, the system-installed assays are configured with settings that are optimized
for each sample type (see “System-installed assays for use with the Oncomine™ Comprehensive Assay
v3 GX” on page 30). To copy a system-installed assay, see the software help system. The following
table provides guidelines on modifying key assay settings and recommendations for quality control

metric threshold values.

IMPORTANT! Modifications to system-installed assay settings have not been verified. We recommend

using system-installed assay settings. Consult your local Field Service Engineer before modifying
default assay settings.

Workflow step Setting Guidelines
Panel Minimum This value determines the number of samples that are allowed on a chip. The
Read Count Genexus™ Software uses this value to calculate how many lanes a run plan
Per Sample uses, then assigns samples accordingly.
Minimum Read Count Per Sample =
(12,000,000 x number of lanes)+(number of samples)
To increase or decrease the sequencing depth, adjust the Minimum Read Count
Per Sample parameter. If higher sequencing depth is desired, decrease the
number of samples per lane or increase the number of lanes used.
For more information, see “Chip capacity by sample type” on page 36.
QC MAPD 0.5
(Sample QC -
DNA)
QC Mapped 200,000
(Sample QC - Reads
RNA)
Mean Read 60
Length (bp)
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(continued)
Workflow step Setting Guidelines
Parameters Sample input | By default, the target sample concentration for the Oncomine™ Comprehensive

Maximum (ng)

Sample input
Minimum (ng)

Assay v3 GX is set to a single value in the assay settings, where a sample input
maximum is set to the same value as sample input minimum. You can modify
the parameters to set a sample concentration range by adjusting the sample
input maximum and minimum values if needed. The target concentration for a
sample is the middle point of the range.

When you modify the sample input maximum and minimum values, the
Sample Concentration Maximum (ng) and Sample Concentration Minimum
(ng) parameters are auto-adjusted to reflect the new maximum concentration
values.

Note: The sample volume that is required for library preparation is not
adjustable. The volume depends on the number of primer pools in the assay,
sample type, and library chemistry. For specific sample volumes to load onto the
sample plate, see “Dilute the samples and load the sample plate” on page 57.

When you set a range for sample concentration in the assay settings,

the instrument does not dilute the sample during the run as long as the
concentration of a sample is within the designated range. If the sample
concentration is outside of the range that is designated in the assay settings,
the instrument dilutes the sample to the target concentration (the middle point
of the range). For more information, see “Plan a Nucleic Acid to Result run” on
page 33.

View assay metrics and the run report

The run report provides detailed information about a run, such as the Total Bases and Final Reads.
The run report contains the assay metrics for all assays in the run.

For a run with only one assay, the run report and assay metrics show the same information for assay
metrics. In addition to the metrics for the assay, the run report shows information about the run and the
instruments used in the run.

To view the Run Report, in the Results / Run Results screen, in the Run Name column, click the run
name of interest. In the Run Summary, click the Run Report tab.

The Run Report is assay-specific and cannot be viewed within the sample results screens. To view the
Run Report, ensure that Select Sample is selected in the Select Sample dropdown menu.
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Assay metrics and the run report

The run report provides detailed information, such as various chip metrics for the run, and well and lon
Sphere™ Particles (ISPs) statistics. For runs with multiple assays, metrics are provided for each assay in
the run. Sequencing metrics are shown at the top of the screen, followed by sample-specific metrics in
the Run Samples table.

Results | 11 v | SelectAssay ¥ | Select Sample ¥
- Run Report Run Summary
1 Started Or 2020-02-04 20:29 ompleted O 2021-06-29 00:45

Analyzis Completed Report Templat MfA

TestRig

2020-02-04 20:29 Completion Date: 2020-02-05 17:15
400
Oncomine Comprehensive v3 - GX5 - DNA and Fusions - w5.0.2
Loading Total Bases Final Reads Raw Read Accuracy
93.33% 5.49G 47,436,114 98.88
Loading 93.33% & Empty Wells 6.67%
93,060,021

SPs{93)

Enrichment 99. 32%0 Unenriched 0,68%

92,427,654
Library 99.87% @ Control I15Ps 0.13%
92,306,292

Final Reads 51.39% (?) Filtered out 48.61%

Loading Density

47,436,114
Final e
Run Samples B Export To Excel
Nucleic Acid Total Mean Read >=0Q20 Mapped On Target Mean
Sample Name Type Barcode Reads Length Bases Reads Reads Depth Uniformity  Read Length Histogram
4 DHA lonDual_0165, 5725165 112 553,068,835 5619415 85,265 1,585 96.05% v T b

Barcode-specific metrics for barcodes that are included in the run are listed in the Barcodes With
Reads Reported table, which follows the Run Samples table. The CSA file for the run contains
information for barcodes that are not assigned to samples in the run. Information in the CSA file can
help you troubleshoot results, if needed. For information about how to download the CSA file, see the
software help system, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Table 16 Run Report

Metric Description
Loading The number and percentage of total addressable wells on the chip that contain an ISP.
Enrichment The number and percentage of wells ISPs that contain live ISPs.
Library The number and percentage of wells with live ISPs that contain Library ISPs.
Final Reads Library reads passing all filters that are recorded in the output BAM files.
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Table 16 Run Report (continued)

Metric

Description

Total Bases

The number of filtered and trimmed base pairs that are reported in the output BAM file.

Raw Read Accuracy

The raw read accuracy across each individual base position in a read calculated as, (1-
[total errors in the sequenced reads]/[total bases sequenced]) x 100. Raw read accuracy

is measured at each base across the length of the read and is based on 1x sequencing
coverage; raw read accuracy is not based on consensus accuracy across multiple reads for
the same base position.

Wells with ISPs

The number of wells that contain an ISP.

Unenriched

The number and percentage of wells with ISPs that do not contain live ISPs.

Total Addressable
Wells

Wells on the chip that can be physically reached by a library.

Empty Wells

The percentage of total addressable wells on the chip that do not contain an ISP.

Wells with Live ISPs

Loaded wells with ISPs with a signal of sufficient strength and composition to be associated
with the library or control fragment key.

Wells with Library
ISPs

Loaded wells with live ISPs with a key signal that is identical to the library key signal.

Control ISPs Loaded wells with live ISPs with a key signal that is identical to the control fragment key
signal.
Filtered out The total percentage of filtered reads, or the sum of the percentages of polyclonal, low
quality, and adapter dimer reads.
Polyclonal Wells with a live ISP that carries clones from two or more templates.
To view polyclonal metrics, mouse over the first low quality portion (gray) of the Final Reads
bar plot.
Final Reads 51.39% @ Filtered out 48.61%
47,436,114 I
‘ .
Final Reads{47,436,114) / Wells with Library 15Ps(92,306,292 | Po|yc|ona|: 38983860 (3389?@3
Low Quality Loaded wells with a low or unrecognizable signal.
To view polyclonal metrics, mouse over the second low quality portion (gray) of the Final
Reads bar plot.
Final Reads 51.39% @ Filtered out 48.61%
47,436,114
Final Reads{4T 436,114) / Wells with Library 15Ps(92,306,252) ‘ LO\N Quallty 20182641 {1754%})
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Table 16 Run Report (continued)

Metric

Description

Adapter Dimer

Loaded wells with a library template of an insert size less than 8 bases.
To view adapter dimer metrics, mouse over the lightest gray portion of the Final Reads bar
plot.

Final Reads 51.39% (@ Filtered out 48.619%

47,436,114 N
nal Reads(47,436,114) / Wells with Library ISPs(92,306,292 ‘ Adapter Dimer: 34924 (0.03%)

Loading Density

A visual representation of chip loading. Red color indicates areas of higher density of
loading. Blue color indicates areas of lower density of loading. The following example
shows a sequencing experiment where two lanes on the chip are uniformly loaded with
ISPs.

Loading Density

Table 17 Run Samples

The Run Samples table lists read data for each individual sample in the assay.

Column

Description

Sample Name

The unique identifier created when the sample was entered in the software.

Nucleic Acid Type The sample nucleic acid type, such as DNA or RNA.

Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for
a sample.

Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to

the sample.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases

The total number of called bases that have =99% accuracy (or less than 1% error rate)
aligned to the reference for the sample.

Mapped Reads

The number of reads that are mapped to the reference file.

On Target Reads

The percentage of sequencing reads mapped to any target region of the reference.

Mean Depth

The average number of reads of all targeted reference bases.
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Table 17 Run Samples (continued)

Column Description

Uniformity Uniformity of Base Coverage. The percentage of bases in all targeted regions (or whole
genome) with a depth of coverage =20% of the mean base read coverage.

Read Length A histogram that presents all filtered and trimmed library reads that are reported in the
Histogram output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

0 50 0o 150 200 250 300

Table 18 Barcodes with Reads Reported

The Barcodes with Reads Reported table lists barcode-specific metrics

Column Description
Barcode The unique dual barcode assigned to a single DNA or RNA library for a sample.
Total Reads The total number of filtered and trimmed reads assigned to the specific dual barcode. The

reads are independent of length reported in the output BAM file.

Mean Read Length | The average length, in base pairs, of usable library reads for each barcode.

=Q20 Bases The total number of called bases that have =99% accuracy (or less than 1% error rate) aligned
to the reference for the barcode.

Download a run report

You can download a run report summary in PDF format. The run report includes assay metrics and the
record of reagents that were used in a run. For information about the contents of the run report, see
“View assay metrics and the run report” on page 116. If you entered extraction kit barcodes for samples
when you prepared library batches or when you planned the run, the extraction kit barcodes are listed in
the run report.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample name of interest.

3. Click the Reports tab.

Multiple panes including a Run Report pane, a Variant Report pane, and any panes for
customized reports that have been generated are shown.

4. Inthe Run Report pane, click Download Report to download a run report summary in PDF
format.
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Edit the QC parameters of an assay

Manager- and administrator-level users can edit the QC parameters of any locked assay, including
system-installed assays, if needed. When the QC parameters are changed, the edited QC parameters
are applied to any new run that uses the assay. Edits to QC parameters do not affect runs that use the
assay and are completed before edits are made.

1. In the menu bar, click Assays » Manage Assays.

2. In the Manage Assays screen, hover the pointer over the row of the assay, then click Edit QC.

Genexus | lon Torrent Dashboard Samples Runs Results Assays

Filter Assays By... *

ated On

Ressearch Cre:
Assay Full Name T AssayName n Application T Fanal T cCreatedBy
) tem Installed 202

System 21-09-27 13:59

v3 . GX5-wS5.0.2-DNA

o arehensive
O )2 INA tem Instal

Oncaring Comprahensive va - GXE - wE.0.2
OCAV3 DNA Fus w5.0.2 DNA and Fusions comina Comprehenshis a5 - W py | Audit | Download Paramete

and Fusions Panel

The Edit QC dialog window opens.
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CF-1 Control

Metric Threshold v

NTC QC-DNA

Metric Threshold v

Min Average Reads Per Lane

Min Base Call Accuracy

Min Mean AQ20 Read Length (bp)

Max Average Base Coverage Depth

Max Mean Read Length (bp)

NTC QC-RNA Purification QC - DNA
Metric Threshold v Metric Threshold +
Max Mapped Reads Min Sample Concentration DNA (ng/ul) 111
Max Sample Concentration DNA (ng/ul) 1136.64
Max Mean Read Length (bp)
Purification QC - RNA Run QC
Metric Threshold + Metric Threshold +
Min Sample Concentration RNA (ng/ul) 0.95 Min Key Signal
Max Sample Concentration RNA (ng/ul) 972.8
Min Percent Loading
Min Raw Read Accuracy
Sample QC - DNA Sample QC - RNA
Metric Threshold v Metric Threshold +
Max MAPD 0.5 Min Mapped Reads 200000
Min Mapped Reads ot Set Min Mean AQ20 Read Length (bp)
Min Mean AQ20 Read Length (bp) Min Mean Read Length (bp) 60

Min Mean Read Length (bp)

Min Uniformity Of Amplicon Coverage

3. Edit the QC parameters as desired.

To reset the QC parameters to the original values in a subsection, click Reset in the upper right

corner of the subsection.

4. Click Save.

The new QC parameter values are saved and applied in any run that uses the assay after the changes

are saved.
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Requirements for Oncomine™ Comprehensive Assay v3 GX
variant annotation

Oncomine™

Variant type Oncomine™ Variant class Annotation criteria
Gene class
Copy number Gain-of- Amplification e SVTYPE = "CNV"
amplification Function e FILTER = "GAIN"

® Ocecurs in a designated copy-gain gene

Long deletion Loss-of- LongDel * Positive mutation call
Function ®* SVTYPE = "LongDel"

Gene fusion Gain-of- Fusion * SVTYPE = "Fusion"
Function * FILTER = "PASS"

* |s atargeted fusion isoform

Non-targeted Gain-of- NonTargetedFusion * SVTYPE = "Fusion"
fusion Function * FILTER = "PASS"

* Non-Targeted field is present

* NT_FUSION_IN_FRAME is not FALSE

¢ NT_FUSION_DRIVER_INVOLVED is not FALSE
¢ NT_FUSION_SECONDARY is not TRUE

RNA exon Gain-of- RNAExonVariant * SVTYPE = "RNAExonVariant" or "Fusion"
variant Function e FILTER = "PASS"
* |s atargeted RNA exon variant

Loss-of- Loss-of- Truncating * Positive mutation call

function Function * Functional impact is frameshift block
truncating de substitution, frameshift deletion, frameshift
novo mutation insertion, or nonsense

® Occurs in a loss-of-function gene

Missense Gain-of- Hotspot * Positive mutation call
hotspot Function * Functional impact is missense
mutation . " .
Loss-of- ¢ Transcript and codon position occur in
Function predefined missense hotspot list
In-frame Gain-of- Hotspot * Positive mutation call
hotspot Function * Function, transcript, and coding syntax occur in
mutation Loss-of- predefined in-frame hotspot list
Function
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(continued)
- ncomine™ . . . o
Variant type STl Oncomine™ Variant class Annotation criteria
Gene class
Splice site Gain-of- Hotspot Positive mutation call
hotspot Function Transcript, location, and exon occur in
mutation Loss-of- predefined splice site hotspot list
Function
Intronic hotspot Gain-of- Hotspot Positive mutation call
mutation Function Transcript, location, and coding syntax occur in
Loss-of- predefined intronic hotspot list
Function
Promoter Gain-of- Hotspot Positive mutation call
hotspot Function Transcript, location, and coding syntax occur in
mutation Loss-of- predefined promoter hotspot list
Function
Gain-of- Gain-of- Hotspot Positive mutation call
function Function Function, transcript, and coding syntax occur in
truncating predefined truncating hotspot list
hotspot . . .
) Occurs in a gain-of-function gene
mutation
Loss-of- Loss-of- Truncating Positive mutation call
function Function Function, transcript, and coding syntax occur in
truncating predefined truncating hotspot list
hotsppt Occurs in a loss-of-function gene
mutation
MNV hotspot Gain-of- Hotspot Positive mutation call
mutation Function Transcript and coding syntax occur in MNV
Loss-of- hotspot list
Function
EGFR exon 19 Gain-of- EGFRExon19Deletion Positive mutation calll
deletionl'] Function Functional impact is nonframeshift deletion,
nonframeshift block substitution
Deletion impacts codons 744-761 of EGFR
EGFR exon 20 Gain-of- EGFRExon20Insertion Positive mutation call
insertion('l Function Functional impact is nonframeshift insertion,
nonframeshift block substitution
Insertion impacts codons 762-775 of EGFR or
variant is in EGFR exon 20 insertion confirmed
list
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(continued)
Variant type Oncomine Oncomine™ Variant class Annotation criteria
Gene class
ERBB2 exon 20 Gain-of- ERBB2Exon20Insertion Positive mutation call
insertionl] Function Functional impact is nonframeshift insertion,
nonframeshift block substitution
Insertion impacts codons 770-783 of ERBB2
KIT exon 11 Gain-of- KITExon11Deletion Positive mutation call
deletionl] Function Functional impact is nonframeshift deletion,
nonframeshift block substitution
Deletion impacts codons 550-580 of KIT
Alternatively, mutation occurs in splice site
flanking the 5' end of exon 11
KIT exon 11 Gain-of- KITExon11Insertion Positive mutation calll
insertionl] Function Functional impact is nonframeshift insertion,
nonframeshift block substitution
Insertion impacts codons 550-580 of KIT
MET exon 14 Gain-of- METExon14Skipping Positive mutation call
skipping!" Function Location is splice site in MET exon 14, is intronic
>= 4bp deletion in 30 nucleotides preceding
MET exon 14, or variant is in MET Exon 14
Skipping confirmed list
PDGFRA exon Gain-of- PDGFRAExon18Deletion Positive mutation call
18 deletionl'] Function

Functional impact is nonframeshift deletion,
nonframeshift block substitution

Deletion impacts codons 841-847 of PDGFRA

' For more information, see “lon Torrent™ Class-Based Variants” on page 126.
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lon Torrent™ Class-Based Variants

lon Torrent™ Class-Based Variants are a set of logic-based rules that Genexus™ Software uses to
computationally identify and annotate novel mutations in important genomic variant classes. The
annotation logic is based on scientific literature evidence. Details about the logic follow.

EGFR exon 19 deletion

Background: Epidermal growth factor receptor (EGFR) is a transmembrane receptor protein made
up of 1210 amino acids and located on chromosome 7p11.2. EGFR has 31 exons— exons 2-4

and 8-12 encode the ligand binding domains, exons 5-7 and 13-16 encode the cysteine rich
domain, exons 18-24 encode the tyrosine kinase domain (TKD), and exons 25-28 encode the
autophosphorylation region [PMID: 17318210]. Mutations in EGFR often target the TKD which
make up the ATP-binding pocket of the enzyme [PMID: 17318210]. Exon 19 deletions are indels
that range between 15-18 bp in length and usually occur within codons 746-756 [PMID: 23768755,
PMID: 22190593, PMID: 26933124, PMID: 24163741]. In non-small cell lung cancer (NSCLC),
EGFR exon 19 deletions, located within codons 746-750, represent 45-50% of somatic mutations
[PMID: 26933124, PMID: 24163741]. Exon 19 deletions result in constitutive activation of the
receptor tyrosine kinase and hyperactivation of downstream signaling pathways [PMID: 29455648].

CBYV Criteria: The boundaries defined to capture EGFR exon 19 deletions as a class-based variant
start at codon 744 and end at codon 761, which encompass common and rare indels [PMID:
30473385].

EGFR exon 20 insertion

126

Background: Epidermal growth factor receptor (EGFR) is a transmembrane receptor protein made
up of 1210 amino acids located on chromosome 7p11.2. EGFR has 31 exons— exons 2-4 and 8-12
encode the ligand binding domains, exons 5-7 and 13-16 encode the cysteine rich domain, exons
18-24 encode the tyrosine kinase domain (TKD), and exons 25-28 encode the autophosphorylation
region [PMID: 17318210]. Mutations in EGFR often target the TKD which make up the ATP-binding
pocket of the enzyme [PMID: 17318210]. In-frame insertions within exon 20 of EGFR are the third
most common type of mutation found in NSCLC, representing 4-12% of all EGFR mutations in
NSCLC [PMID: 31208370]. EGFR exon 20 encompasses codons 762 to 823. Exon 20 insertions
commonly involve codons 762 to 774 wherein codons 762-766 make up the c-helix and codons
767-774 make up the activation loop [PMID: 31208370, PMID: 30854234]. EGFR exon 20 insertions
do not alter the receptor binding affinity; however, it is suggested that the location of exon 20
insertions stabilizes its active confirmation [PMID: 30854234, PMID: 27843613].

CBYV Criteria: The boundaries defined to capture EGFR exon 20 insertions as a class-based

variant start at codon 762 and end at codon 775. Additionally, known EGFR exon 20

insertions p.A763_Y764insFQEA and p.A763_Y764insLQEA, represented as c.2284-6_2284-
5insTCCAGGAAGCCT and ¢.2284-9_2284-8insCCCTCCAGGAAG due to left alignment into the
intronic region, are included in this rule.
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ERBB2 exon 20 insertion

* Background: Erb-b2 receptor tyrosine kinase 2 (ERBB2) is a transmembrane glycoprotein located
on chromosome 17q12 [PMID: 25276427]. ERBB2 (also known as HER2) has 27 exons— exons
2-4 and 9-12 encode the extracellular receptor L domains, exons 5-8 encode the furin like domain,
exons 13-16 encode the growth factor receptor domain IV, exon 17 encodes the transmembrane
domain, and exons 18-24 encode the tyrosine kinase domain (TKD) [PMID: 22761469, PMID:
29420467]. In lung cancer, the most recurrent ERBB2 activating mutations include in-frame
exon 20 insertions [PMID: 30425522]. ERBB2 exon 20 involves codons 770 to 831 and majority
of exon 20 insertions occur between codons 775 and 781 within the kinase domain [PMID:
29686424, PMID:22761469]. Insertions at the C-terminal end of ERBB2 exon 20 induce a change
in conformation of the a-C helix leading to a constitutively active formation which affects the
drug-binding pocket [PMID: 29686424].

® CBYV Criteria: The boundaries defined to capture ERBB2 exon 20 insertions as a class-based
variant start at codon 770 and end at codon 783.

KIT exon 11 insertion and KIT exon 11 deletion

* Background: KIT, also known as CD117, is a proto-oncogene receptor tyrosine kinase made up of
976 amino acids located on chromosome 4g12 [PMID: 16689459]. KIT is a member of the PDGFR
type lll receptor tyrosine kinase family [PMID: 26579483; PMID: 26309392]. KIT has 21 exons—
exons 1-9 encode the extracellular ligand-binding region containing five Ig-like domains, exon 10
encodes the transmembrane (TM) domain, and exon 11 encodes a cytoplasmic juxtamembrane
region. The intracellular region of KIT is encoded by exons 12-21, wherein, exons 12-14 encode
the tyrosine kinase domain 1, exons 15-16 encode the kinase insert (Kl) region, and exons 17—

19 encode the tyrosine kinase domain 2 [PMID: 24449920, PMID: 27536065, PMID: 31378162,
PMID: 15342366, PMID: 17555444]. Recurrent somatic KIT alterations are observed in both solid
and hematological cancers and include activating mutations such as single nucleotide variants
(SNVs), small duplications, and complex in-frame insertions or deletions (indels). Mutations in KIT
exons 8, 9, 11, and 17 disrupt the auto-inhibitory mechanisms and lead to constitutive activity
[PMID: 27536065]. While mutations in exons 8 and 17 are common in myeloid cancers, 60-70%
of somatic mutations (including SNVs and indels) in gastrointestinal stromal tumor (GIST) occur in
exon 11, which encodes the juxtamembrane domain [PMID: 27536065, PMID: 22588877, PMID:
23678293; NCCN-GIST].

® CBV Criteria: The boundaries defined to capture KIT exon 11 insertions and deletions as a class-
based variant start at codon 550 and end at codon 580.

MET exon 14 skipping

* Background: The MET proto-oncogene is a receptor tyrosine kinase made up of 1390 amino acids
and is located on chromosome 7g31 [PMID: 15735036]. MET has 21 exons containing three main
structural domains—an extracellular Sema domain in exon 2, a juxtamembrane domain in exon
14, and a tyrosine kinase domain in exons 15-21 [PMID: 28376232, PMID: 9380410]. Splice site
mutations flanking exon 14 are observed in 4% of non-small cell lung cancer (NSCLC). These
mutations include canonical splice site mutations affecting exon 14 and deletions that extend into
the splicing motifs within intron 13 [PMID: 25971938, PMID: 27343443]. Such mutations disrupt
splicing leading to the formation of an alternative transcript that joins exon 13 directly to exon 15
and skips exon 14 entirely. The MET exon 14 skipping transcript lacks the juxtamembrane domain
that contains the recognition motif for ubiquitin-dependent proteolysis and thus leads to a marked
increase in steady-state level of the MET protein [PMID: 28164087].
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® CBYV Criteria: The boundaries defined to capture MET exon 14 skipping as a class-based variant
can be summarized into four individual rules: (a) has transcript = NM_001127500.3, exon = 14,
and location = splicesite_3 (at ¢.2942) or splicesite_5 (at ¢.3082), (b) is an intronic deletion = 4bp
impacting 30 nucleotides preceding exon 14, (c) is a missense variant at ¢.3082 [PMID: 27343443,
PMID: 26729443, PMID: 25971938, PMID: 25898962, PMID: 25898965, PMID: 31472177], (d) is
one of the following variants with confirmed skipping defined as ¢.3082delG [PMID: 25971938,
PMID: 27343443], ¢.3066_3081delAGCTACTTTTCCAGAA, c.3075_3082del [PMID: 31472177], or
c.3080_3081delAA [PMID: 26729443].
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PDGFRA exon 18 deletion

¢ Background: Platelet derived growth factor receptor alpha (PDGFRA) is a cell surface tyrosine
kinase receptor made up of 1089 amino acids and located on chromosome 4g12. PDGFRA
contains 23 exons —exons 1-2 encode the signaling peptide, exons 3-10 encode the extracellular
domain, exon 11 encodes the transmembrane domain, exon 12 encodes the juxtamembrane
domain, and exons 13-23 encode the kinase domain [PMID: 33449152]. Mutations in PDGFRA
often target the activation loop located within exon 18. Additionally, mutations targeting the the
juxtamembrane domain and the N-lobe of the kinase domain found within exons 12 and 14 to
a lesser extent. [PMID: 30778083, PMID: 33449152, PMID: 15146165]. Activating PDGFRA exon
18 mutations such as V561D, N659K, D842V, and in-frame deletions are observed in 30-40% of
KIT-negative gastrointestinal stromal tumors (GISTs) [PMID: 17193822, PMID: 15928335, PMID:
12522257, PMID: 23970477]. Specifically, PDGFRA in-frame deletions in codons 841-847 make up
23% of all exon 18 mutations [PMID: 15146165].

® CBYV Criteria: The boundaries defined to capture PDGFRA exon 18 deletions as a class-based
variant start at codon 841 and end at codon 847.
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Reanalysis

If a run fails to meet one or more QC parameters defined by the assay, you can adjust the assay
parameters and reanalyze a run or a sample from the run.

Reanalysis of runs can start from the alignment, basecalling, or signal processing steps. A sample can
be reanalyzed starting only from the alignment step.

For more information, see the Genexus™ Software 6.8 Help or the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409).

Install software and assay definition file updates

Administrator-level users can select 3 (Settings) » Software Updates to view:
* The currently installed software versions for each software module, assay definition file, plugin, and
configuration package installed on the system under the Installed Software link.

* Check for new software updates that are available to be downloaded and installed under the
Software Updates link.

In order to download and install software and assay definition file (ADF) updates, you must first:

* Either, configure a Thermo Fisher™ Connect Platform account or format a USB drive for the
software update. For instructions, see the software help system, or the Genexus™ Software 6.6
User Guide (Pub. No. MAN0024953). For users who have set up an account, @ (Notification)
appears in the Genexus™ Software banner at the top of the screen upon login when updated
software packages are available for download.

* Ensure that the Genexus™ Integrated Sequencer is running the latest Genexus™ Software version.

IMPORTANT! Do not reboot the system during installation.

* Download and install software updates directly.
a. In the menu bar, click 3 (Settings) » Software Updates, then click Software Updates in the
upper right corner of the screen.
The Software Updates screen opens with App Store enabled.

Genexus ' lon Torrent Dashboard Samples Runs Results Assays fin} o] 2

Category Instrument Type Installed Version Installed On

b. From the Filter Software by dropdown list, select Software to view available software
package updates or Assay Definition Files to view available assay package updates.

The list of available updates appear.
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C.

d.

In the Actions column, in the row of the package of interest, click Download.
After completion of the download, the Download link changes to an Install link.

Click Install, then click Yes to confirm installation.

* Download and install software with a USB drive

a.

b.

g.

Sign in to the Thermo Fisher App Store on Connect at apps.thermofisher.com.
Click i2 (AppConnect), then under Resource Libraries, click lon Torrent™ Genexus™.

Click Software Update, then in the row of the package of interest, click #% (Download).

. Copy the downloaded package (.zip) to the /media/usbinstall folder in the USB drive,

then insert the drive into one of the USB ports at the back of the Genexus™ Integrated
Sequencer.

In the menu bar, click 3 (Settings) » Software Updates, then click Software Updates in the
upper right corner.

Select USB.

Click Install, then click Yes to confirm installation.

When installation of the package is complete, click Installed Software to verify the installation.
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This appendix outlines major improvements in Oncomine™ Comprehensive Assay v3 GX, issues fixed
and known issues to be fixed in subsequent releases.

Oncomine™ Comprehensive Assay v3 GX ADF 6.0.2

The Oncomine™ Comprehensive Assay v3 GX provides comprehensive genomic profiling with analysis
of SNVs, INDELs, CNVs and gene fusions from 161 unique genes. The updated Assay Definition File
(ADF) version 6.0.2 requires Genexus™ Software 6.8.2 or later and includes the following improvements:

Assay performance improvements —workflow parameters are further optimized to increase assay
robustness and reproducibility.
Variant calling:

— lon Torrent™ Variant Caller (TVC) v5.20 module was updated to v5.20-17. The version number
is visible in the header of the VCF file.

— Sequence variant baseline, hotspots parameters were further optimized to better detect key
variants in BRCA2, NOTCH2, PIK3CA, RNF4, BRAF, MET, RAD50, TERT, KIT, PDGFRA genes.

Fusions—Fusion Reference and Property files updated to include additional EML4-ALK fusion
isoforms.

Variant filter chain—Updated to Oncomine Extended (6.8) Filter Chain to enable identification of
additional variants.

Oncomine™ Variant Annotator (OVAT) Ruleset—Updated to enable KIT and PDGFRA Class-Based
Variants and incorporate updated hotspot variants. For a complete list of supported Class-Based
Variants, see “Requirements for Oncomine™ Comprehensive Assay v3 GX variant annotation” on
page 123.

Issues fixed in Oncomine™ Comprehensive Assay v3 GX ADF 6.0.2

In the Oncomine™ Comprehensive Assay v3 GX w5.0.2 ADF file, the PCR amplification temperature
was 99°C which may contribute to high MAPD, low uniformity, and low total AQ20 reads.

To address this problem, the run parameter (amplifyTargetPCRProfile) value for PCR
amplification temperature in library preparation is updated to 98°C in all three workflows.

To track samples in Genexus™ Software analysis using the SamplelD plugin, the assay had to be
manually edited to select the plugin.

In the new Oncomine™ Comprehensive Assay v3 GX ADF 6.0.2 the SamplelD plugin (v5.16.0.3) is
preconfigured for DNA only, DNA, and Fusion workflows.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Biological hazard safety

A
A

132

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetyMicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.
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Documentation and support

Related documentation

Document Publication number
Genexus™ Integrated Sequencer User Guide MANO0017910
Genexus™ Purification System User Guide MANO0018475
Genexus™ Software 6.8 User Guide MANO0026409
Genexus™ Software 6.8 Help Available in the software
Oncomine™ Reporter User Guide MANO0018068
Qubit™ dsDNA HS Assay Kits User Guide MANO0002326
Qubit™ RNA HS Assay Kits User Guide MANO0002327

Note: For additional documentation, see “Customer and technical support”.
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Appendix E Documentation and support
Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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